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Additional information 
Additional free publications are available for download at the STAR DMS product page. 

 

Table 0-1: Related documentation 

Documents Document number 

PGC5000 Series Operating instructions OI/PGC5000-EN 

PGC5000 Generation 2 Operating Instructions OI/PGC5000/Gen 2-EN 

VistaNET VN2300 Installation Guide 2300-IG 

VistaNET VN2300 User’s Guide 2300-UG 

VistaNET VN2300 Administrator’s Guide 2300-AG 

  
 

Cyber security 
This product is designed to be connected to and to communicate information and data via a network 
interface. It is the operator’s sole responsibility to provide and continuously ensure a secure 
connection between the product and your network or any other network (as the case may be). The 
operator shall establish and maintain any appropriate measures (such as, but not limited to, the 
installation of firewalls, application of authentication measures, encryption of data, installation of anti-
virus programs, etc.) to protect the product, the network, its system, and the interface against any 
kind of security breaches, unauthorized access, interference, intrusion, leakage and/or theft of data or 
information. ABB and its affiliates are not liable for damages and/or losses related to such security 
breaches, any unauthorized access, interference, intrusion, leakage and/or theft of data or 
information. 

Although ABB provides functionality testing on the products and updates that it releases, the customer 
should institute its own testing program for any product updates or other major system updates (to 
include, but not limited to, code changes, configuration file changes, third party software updates or 
patches, hardware change out, etc.) to ensure that the security measures that the customer has 
implemented have not been compromised and that system functionality in the customer's 
environment is as expected. 

It is recommended to implement rate limiter at the network level. 

The Modbus protocol is an unsecured protocol. As such, the intended application should be assessed 
to ensure that these protocols are suitable before implementation. 

The OPC-DA protocol is an unsecured protocol. As such, the intended application should be assessed 
to ensure that these protocols are suitable before implementation. 

The ABB VistaNET protocol is an unsecured protocol. As such, the intended application should be 
assessed to ensure that these protocols are suitable before implementation. 

The STAR Server uses an SA account (VistaSTARAdmin) for SQL Server. The default password is 
“RATSatsiV” for SQL Server 2008 R2, and “RATSatsiV!” for SQL Server 2022. 

  

https://new.abb.com/products/measurement-products/analytical/analyzer-networks-vistastar
https://new.abb.com/products/measurement-products/analytical/analyzer-networks-vistastar
https://search.abb.com/library/Download.aspx?DocumentID=OI%2FPGC5000-EN&LanguageCode=en&DocumentPartId=&Action=Launch
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1 System overview 
STAR DMS is the next generation of data system interface software designed to unify the legacy 
generation instrumentation that we have in the field with the current PGC5000 series analyzers.   
STAR DMS uses many of the existing instrumentation and applications found in VistaNET. STAR DMS 
introduces two additional applications: the STAR Client and the STAR Server. 

1.1 Redundancy vs. concurrency 
STAR DMS redundancy occurs when data is sent to a primary address, which does not acknowledge 
receipt before the specified time-out occurs. The sending device then sends the same data to a 
secondary address. This results in one copy of the data reaching the desired device. 

There may be situations where this redundancy is not adequate. For example, a STAR DMS could have 
two PCs, each with a database management software application. Under such circumstances, it may 
be desirable to send the same information to both databases simultaneously; this is concurrency.   

The STAR DMS achieves concurrency by having multiple entries of the same device type at the client’s 
subscriber list, each entry with its own unique primary address. An analyzer’s subscriber list 
configured in this manner and requiring database management services from software applications 
would send the same analysis results to both databases at the end of analysis. 

1.2 Devices 
This section provides a quick introduction to the devices and software applications that make up a 
STAR DMS.  Before you can use any STAR DMS application, you must set it up. The System 
Administrator usually performs setup when installing the STAR DMS. If you have difficulty using STAR 
applications, verify their proper installation with the system administrator. 

1.2.1 STAR client 
The STAR Client is a Windows™-based application that provides a centralized launch point for the 
legacy VistaNET applications and current versions of RUI. It also allows the user to view trends and 
chromatograms that are historically stored in the STAR Server. 

1.2.2 STAR server 
The STAR Server is an appliance server that saves data from PGC5000 (version 4), PGC2000/3100, 
PGC5000 Generation 2, PGC1000/NGC, RVP, Multiwave, and OPC DA 2.0 compatible servers. The 
STAR Server comes in two different licensing levels: 1-15 and 1-50. If the 1-50 level is purchased, the 
server contains a drive array of eight terabytes in a RAID 5 configuration. 

1.2.3 Reporter 
The Reporter is a software application that serves multiple functions associated with event logging and 
analysis reports. The Reporter application: 

 Displays selected analysis reports and event messages on the PC 
 Logs selected events and analysis reports to send to a printer 
 Saves selected analysis event reports and system event reports to local or network files 
The Reporter can also be set to run as a Windows Service. 

1.2.4 Remote user interface 
The various Remote User Interfaces (RUIs) have similar functions: configuration, programming, 
control, and diagnostics of analytical devices or remote applications. 

1.2.5 STAR Gateway 
The STAR Gateway is a stand-alone assembly that delivers all analysis results and status changes to 
the DCS in a timely and orderly fashion. The STAR Gateway connects the DCS to the analytical 
devices and applications that make up the STAR DMS. This includes status, analysis results, and 
events generated by the device or application. The STAR Gateway can communicate to the DCS via 
OPC DA, Modbus TCP, or Modbus RTU. 

1.2.6 PGC5000/PGC5000 generation 2 
For PGC5000 and PGC5000 generation 2 process gas chromatographs, the controller's function in the 
system is to provide analysis results and status change information to other applications as needed. 
The PGC5000 connects to STAR DMS through its dual Ethernet connections. 
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1.2.7 Multiwave 
The Multiwave is a stand-alone analyzer that makes continuous measurements. Its function within 
STAR is to transfer all the analysis results and status change information to other applications as 
needed. 

1.2.8 RVP 
The Reid Vapor Pressure (RVP) is a stand-alone analyzer that accurately measures Reid vapor 
pressure throughout the gasoline range and its feedstocks. It transfers the analysis results to various 
applications within the STAR DMS. 

1.2.9 ABB OPC server 
The OPC Server accepts analysis results from other instrument devices. Before a remote device can 
communicate with the OPC Server, the remote device must have entries in its subscriber list to route 
data to the IP address of the OPC Server. The OPC Server runs as a Windows service. 

1.2.10 OPC concentrator 
The OPC Concentrator collects data from any Data Access 2.0 compliant OPC Server. The OPC 
Concentrator runs as a Windows™ Service. When it is activated, the OPC Concentrator will appear in 
the Devices tab of the STAR Client. The STAR Client is used to view the stored data and acts as the 
configuration tool. 

1.2.11 PGC1000 concentrator 
The PGC1000 Concentrator acts as a single collection point for data from PGC1000/NGC devices. The 
PGC1000 Concentrator runs as a Windows Service, appears in the Devices tab of the STAR Client, and 
is used as the configuration tool to get data from the PGC1000/NGC devices. 

1.2.12 VNSA 
VNSA provides the connection that allows legacy devices and applications to access the STAR DMS.  
The Access Control List, Device Definition Table, and Routing tables are also shared with STAR DMS.  
For more information on VNSA and VNSA-related issues, refer to Administration Guide 2300-AG or 
Installation Guide 2300-IG. 

 

IMPORTANT NOTE: Version 4.x.x.x of the VNSA cannot contain entries for an OPC Server. 

1.2.13 VN service 
VN service is a Windows service that directs messages to their appropriate Windows application. 

1.3 Passwords 
If your system is set up with usernames and passwords, you must have the appropriate password to 
gain access to devices on STAR DMS. User passwords have three levels: read only, read/write, and 
supervisor. Only users with read/write and supervisor passwords can change data and save it. If you 
do not know your username or password, contact your System Administrator before proceeding. 

The analyzer is shipped from the factory with no users configured. If the analyzer is added to an 
existing network with other PGC5000s or a STAR DMS, the analyzer’s access control list (ACL) will be 
populated by another node in the network. If no other PGC5000s or STAR DMS servers exist in the 
network, the user can add a user if desired. The first user must be added as a supervisor level user. 

User passwords should be strong passwords. Usernames and passwords should be limited to English 
keyboard characters, as other language characters are not visible on the PGC5000 LUI and RUI. You 
should always take great care when you select a password. A strong password has the following 
characteristics:  

 Is between 8 and 20 characters long 
 Combines letters, numbers, and English keyboard symbols within the password 
 Is not found in a dictionary 
 Is not the name of a person 
 Is not the name of a user 
 Is not the name of a computer 
 Is changed regularly – at least every 90 days 
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 Is significantly different from previous passwords 
Netlock analyzers permit read/write only at their own front panel; remote users have read only 
capability regardless of other permissions. These analyzers require the use of a supervisor password 
to change any data. 

 

IMPORTANT NOTE: To prevent unauthorized access, ABB highly recommends that you change 
any factory default passwords in your systems. Default passwords must be replaced with the 
customer’s own private passwords. Private passwords must be saved and managed in safe locations 
by authorized personnel only. 

1.4 Application communication ports 
STAR DMS opens the following application ports: 

Table 1-1: Open application ports 

Port  Protocol  Description 
58921 TCP Communication Port 
58921 UDP Utility Port 
58922 TCP STAR Server 
58923 TCP ABB OPC Server 
2 UDP Listening port for VNSA 
109 UDP Port for legacy RD device communication 
59 UDP Port for legacy SD device communication 
28 TCP Port for RVP 
28 UDP Port of legacy HIU device communication 
502 TCP Port for Modbus 
1433 TCP Port for SQL Server 
1434 UDP Port for SQL Server 
Other ports opened for OS level communication 
135 TCP Microsoft® Remote Procedure Call (RPC) 
137 TCP NetBIOS - Name Service 
139 TCP NetBIOS - Session Service 
445 TCP NetBIOS - Session Service 
3389 TCP Microsoft® Terminal Service 
49154 TCP Microsoft® Remote Procedure Call (RPC) 
 

These ports must be opened through network equipment and firewalls. All other ports are explicitly 
closed on STAR DMS products. 

1.5 Multicast addresses 
The STAR DMS uses multicast messages to discover other devices on the network. A multicast 
message is used instead of a broadcast message to allow device discovery over multiple subnets. The 
STAR DMS allows up to 5 hops (time to live, TTL). 

The Multicast address is defaulted to 239.1.1.1 for the primary address and to 239.1.1.2 for the 
secondary address. If a multicast address must be changed, ensure that all devices that need to 
communicate with it are on the correct multicast address. Contact the network administrator for 
available Multicast Addresses. The figure below shows address configuration. The table explains the 
Logging Enabled options.   
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Figure 1-1: Multicast addresses 

 
Table 1-2: VNService Configuration options 

Option  Use 

Reload File Resets the addresses to the defaults 

Save to File To modify only the addresses 

Edit Devices To add devices from foreign subnets into the local subnet if the analyzer 
network is segmented into multiple subnets and the Multicast feature is 
disabled at the switch/router level 

Import Config To use the VNConfiguration.xml file if there are a lot of subnets. Configure 
one subnet and then use Import Config to import the devices from the file 
into the other subnets. The path is: 

(%Install Path%)\STAR\Network\Config\VNConfiguration.xml  

Save with Service Devices To save devices added with the Edit Button and devices from the local 
subnet 

 

2 Installation and startup 
2.1 Wiring guidelines 
Cabling should follow normal Ethernet cabling protocols (see Figure 2-1). 
Figure 2-1: Ethernet cabling 

Analytical
Device 1

Analytical
Device 2

Analytical
Device n

Ethernet
Switch

VN2300DM
Router

Classic
Devices

 

2.2 Subscriber lists 
Every STAR DMS device and most STAR DMS software applications have subscriber lists or server 
lists. A subscriber list identifies where a device will send its data, and on which domain (wire segment) 
it will be sent. Each entry in the subscriber list consists of at least a service provider type, its primary 
address and optional secondary address, and an optional time-out period associated with all service 
requests from this provider. The PGC5000 does not have a timeout setting in its subscriber list. 

2.2.1 PGC5000 subscriber list 
Figure 2-2 illustrates the PGC5000 subscriber list, with the attributes described below. 
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Figure 2-2: PGC5000 Subscriber Table 

 
 NAME: the manually entered name for the specific device or application 
 TYPE: identifies each device and software application in STAR DMS, except for the Remote User 

Interfaces (RUIs). The types for PGC5000 are abbreviated as follows (legacy instruments are not 
supported): 

• RD: Reporter 
• OPC: OPC Server 
• STR: STAR Server 
• MOD: Modbus Master 

 IP ADDRESS: the first address to which an application sends data. If acknowledgement is not 
provided within the specified time-out period, the data will be sent to the secondary address (if 
one has been provided). 

 

IMPORTANT NOTE: If the selected provider does not respond within the time-out period, a Time-
Out alarm or warning will be displayed. 

 SECONDARY IP ADDRESS: the address of the optional secondary service provider. This address 
may be the same address as the primary, but with a different domain, thereby providing 
redundant paths to the same device; or it may be a different device of the same type. 

 ACTIVE: selecting this box makes the device or application active. 
 REPORT: selecting this box activates a report for this device or application; it applies to STAR, 

OPC and RD. 
 EVENTS: selecting this box activates event reports for this device or application; it applies to STAR 

and RD. 
 STATUS CHANGE: selecting this box activates a status change; it applies to STAR and OPC. 
 X: selecting this box deletes the line from the table. 

2.2.2 Legacy subscriber list 
Figure 2-3 illustrates the VistaNET VN2300 subscriber list, with the attributes described below. 



  

892J007MNAE | STAR DMS OI | 13 

Figure 2-3: Typical Legacy Subscriber Table 

 
 Type: identifies each device and software application in STAR DMS, except for the Remote User 

Interfaces (RUIs). The types are abbreviated as follows: 
• RD: Reporter 
• HIU: Host Interface Unit or STAR Gateway 
• SD: Storage Device 

 Timeout: the period of time that a client application will wait before seeking service from the 
optional secondary address or aborting the service request. The default time for most applications 
is two seconds. 

 Address: the first line indicates the first address to which an application sends data. If 
acknowledgement is not provided within the specified timeout period, the data will be sent to the 
secondary address (if one has been provided). The second line, if shown, is the address of the 
optional secondary service provider. This address may be the same address as the primary, but 
with a different domain, thereby providing redundant paths to the same device; or it may be a 
different device of the same type. 

 

IMPORTANT NOTE: If the selected provider does not respond within the time-out period, a time-
out alarm or warning will display. 

 Description: a name supplied by the administrator to identify the specific device in the system. 

2.3 Changing IP address of Windows device 
When you are changing the IP addresses on a STAR DMS Windows device, the following configuration 
changes to the STAR products must be performed. 

1. (%Install Path%)\STAR\Network\VNServiceConfiguration.exe 

2. (%Install Path%)\Wiz.exe (This is the VistaNET 2.0 setup tool.) 

3. (%Install Path%)\STAR\Server\ConfigurationManager.exe (if the device is a STAR Server) 

2.4 Install the STAR Core 
To install the STAR Core, all of the prerequisites are first installed, including the OPC. Then the full 
package of 26 products are installed. Follow the Wizard instructions.  
 

1. From the installation media, run setup.exe selecting the Run as administrator option.  

• If this is an update to the existing installed STAR Core, select the update option and click 
Next.  

• If this is a new installation, it will go directly to the Installation prerequisites dialog box. 
2. Click Install to continue.  
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Figure 2-4: Installation prerequisites 

 
 
PCCU is the Remote User Interface for the NGC or PGC1000 analyzer. Only install it if needed for your 
system environment.  

3. Click Yes for the InstallShield Wizard to proceed to install PCCU or click No to not install PCCU.  

 
 
 

4. After some of the prerequisites, you may be asked to reboot the machine. Please do so if 
requested.  

5. There will be two installations for the OPC Core Components Redistributable (x64 and x86). 
These will run back-to-back. Complete each. Agree to the OPC Core Components 
Redistributable agreement.  

6. Leave the OPC Core default options and click Next. 
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Figure 2-5: OPC installation folder 

 
7. Click Next to confirm the OPC Core installation. 

8. Click Close to complete the OPC Core installation. 

The installation of the prerequisites is now complete. Upon closing the OPC Core Components 
Redistributable installation screen, the STAR Core Welcome screen appears. 

Figure 2-6: STAR Core welcome screen 

 
Proceed to continue to install the STAR Core.  

1. To begin the InstallShield Wizard for STAR Core, click Next.  

2. On the License Agreement screen, read the license agreement, and if acceptable, click Yes. 

3. On the Customer Information screen, enter the applicable information and click Next. 
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4. On the Choose Destination screen, acknowledge the default locations or browse to select 
another location, and then click Next. 

 

IMPORTANT NOTE: A delay of 5-10 minutes after Next is selected is normal. 

5. On the Start Copying Files screen, click Next. 

6. On the Setup Status screen, wait for Setup to perform its tasks. 

7. When the Run VNSA screen appears, click Yes or No, as applicable. 

8. When the OPC Concentrator screen appears, click Yes or No, as applicable. 

9. When the PGC1000 Concentrator screen appears, click Yes or No, as applicable. 

10. When the Vista Reporter appears, click Yes or No, as applicable.  

11. In the Update Configuration dialog box (see Figure 2-7), select the appropriate IP addresses, 
select the desired Logging Enabled button, and click Save to File. See table Table 1-2 for 
details about VNService Configuration options.  

Figure 2-7: Update Configuration dialog box 

 
12. On the Welcome to the VistaNET Configuration Wizard screen, enter the appropriate 

information for your system and click Next. 

13. On the IP Address configuration page, enter the appropriate server/device information and click 
Next. 
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Figure 2-8: IP address Configuration Wizard screen 

 
14. On the essential application IP Addresses screen, add addresses and then click Next. 

15. On the completion VistaNET Configuration Wizard screen, click Finish to save your 
configuration. 

16. The program will initialize your information while the Initializing Features screen displays. 

17. When the Maintenance Complete screen appears (see Figure 2-9), click Finish to restart your 
computer. 

Figure 2-9: Maintenance Complete screen 

 
 

2.5 Update STAR Server 
If update of STAR Core is needed, complete that first before updating STAR Server.  
 
To update the STAR server:  
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1. From the zip file or other media source, select Setup.exe, selecting the Run as 
administrator option. 

2. At the Installer welcome screen, Select Update and click Next. 

Figure 2-10: STAR Server Welcome 

 
3. After the update completes, click Finish. 

2.6 PGC1000 concentrator 
The PGC1000 Concentrator collects data from any PGC1000 or NCG8200 series analyzer. The 
PGC1000 Concentrator runs as a Windows Service, and when activated as described in section 2.4, 
the PGC1000 Concentrator will appear in the Devices tab of the STAR Client (see Figure 2-11). 

Figure 2-11: PGC1000 Concentrator in Devices tab 

 
The STAR Client can be used to view the stored data, and it acts as the configuration tool. To 
configure the PGC1000 Concentrator: 

1. Right click on the PGC1000 Concentrator and the menu shown in Figure 2-12 will appear. 

Figure 2-12: PGC1000 Concentrator menu 

 
2. To choose the STAR Server to be used for storing the data, select Add/Modify STAR Server 

and click on the desired server. 

3. Enter the name of the STAR Server and click OK. The result will give you another level in the 
tree view (see Figure 2-13). 
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Figure 2-13: PGC1000 Concentrator sub-level 

 
 

4. To add a PGC1000 Server, right click on the STAR Server. The Add PGC1000 screen will appear 
(see Figure 2-14). 

Figure 2-14: Add PGC1000 screen 

 
5. Click Add PGC1000. This will allow you to choose the PGC1000 you wish to retrieve data. 

6. In the Add PGC1K screen, enter the IP address of the PGC1000. 

7. Select the PGC1000 and click OK (see Figure 2-15). 

Figure 2-15: Add PGC1K screen 

 

This will result in another level in the tree view, as seen in Figure 2-16. 

Figure 2-16: Third level in PGC1000 Concentrator tree view 

 
8. Right click on a PGC1000/NGC. The Remove PGC1000 screen will appear (see Figure 2-17).   

Figure 2-17: Remove PGC1000 screen 

 

2.7 Startup 
To start any application: 

1. Locate and open the ABB STAR folder from the desktop, or click Start. 

2. Select the application you want to run. 

 

3 STAR client 
The STAR Client provides access to analyzer functions and data. The STAR Client is the portal into the 
STAR DMS. When you launch the STAR Client, Figure 3-1 appears, with its menus and views as 
shown. 
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Figure 3-1: STAR Client Window 

 

3.1 Menu bar 
The items in the menu bar (see Figure 3-2) have submenus to list together similar tasks to be done. 
Each menu item is described in the following sections.  

Figure 3-2: Menu Bar 

 

3.1.1 File 
 Open: opens a file from a saved location on a local PC or other storage device. It allows you to 

open a file in a new window, or overlay a file onto a like-typed window. The files are filtered by 
device type with the default: “Report Files (*.rpt)”. 

 Save: saves the report or trend in the active view to the STAR Server; it only saves data opened 
from the STAR Server, not a local storage location. 

 Save As: saves the report in the active view in its native format (e.g. *.rpt) to a storage location 
such as a local PC or other storage device. (You cannot use “Save As” for a trend.) 

 Save As Image: saves the report or trend in the active view as an image file to a saved location 
on a local PC or other storage device 

 Save Plant View: saves a plant view 
 Print: prints content of the active view in the viewing area 
 Login/Logout: provides security by allowing users different levels of access 
 ACL Editor: allows a user with Supervisor access to assign usernames and passwords for different 

security levels 
 Exit: closes the program 

3.1.2 Edit 
Log in as Normal or Supervisor as required. 

 Add Note: adds a note to a chromatogram or trend (see Figure 3-1) 
 Add Callout Box: adds an anchored callout box to a chromatogram or trend (see Figure 3-1) 
 Clear Annotations: removes all notes and callout boxes 
The STAR Client allows you to add notes and callout boxes to a chromatogram or trend. In this feature 
you can format text in a Note and Callout Box like a word processor. To see this feature, select an 
existing Note or Callout Box. You can highlight text and apply text format to that text, or you can 
select formats as you type. The Note box will remain in the same place you initially created, even 
when the chromatogram is resized. The Callout box will remain anchored to the position you originally 
created, but it may relocate on the screen during resizing. 
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To resize a text box: 

1. Right click on the desired text box to open its dialog box. 

2. Select Resize. 

3. Drag the text box on its edges or corners to resize. 

4. Right click on the desired text box to open its dialog box. 

5. Click Lock Resize. 

 

IMPORTANT NOTE: When you are resizing, the rotation menu item will be disabled. You must 
click Lock Resize to reenable the ability to select rotation. When you are using rotation, the Resize 
button will be disabled. 

To edit text within a text box: 

1. Right click on the desired text box to open its dialog box. 

2. Select Edit Text. 

3. In the text box that appears, highlight the text to be edited. 

4. When you have completed the editing, click OK. 

To rotate a text box: 

1. Right click on the desired text box to open its dialog box. 

2. Select Rotate. 

3. Drag the text box on its edges or corners to rotate, then release.  

4. Right click on the desired text box to open its dialog box. 

5. Click Lock Rotation. 

3.1.3 Templates 
Templates are user-created text files that can be inserted into reports and chromatograms. It requires 
a user to log in as Normal or Supervisor to enable creating, editing and deleting templates. 

 Apply Annotation Template: applies a saved annotation template to a chromatogram or trend 
 Unapply Annotation Template: removes a saved annotation template from a chromatogram or 

trend 
 Create New Annotation Template: allows creation of a new annotation template 
 Edit Annotation Template: allows editing of a saved annotation template 
 Delete Annotation Template: permanently removes a saved annotation template 
 Create Annotation Template from Annotations: creates an annotation template from the 

annotations displayed in the current chromatogram or trend 

3.1.4 Classic applications 
 Configuration Wizard: Enables establishment/modification of the VistaNET configuration 
 Client Configurator: Application used for the creation of configuration files for Gateway OPC 

clients, persist files for OPC server, and MODBUS configuration files for the PGC5000 series 
analyzers 

 VNSimulator: Simulates instrument data for testing purposes only (not to be run in a functioning 
system). This is primarily used to simulate analyzer data through the STAR Gateway to a DCS 
prior to receiving the device on site.  

 VistaReporter: Enables display, storage and printing of reports and events 
 Browse: Enables search for files, documents, etc. 

3.1.5 Tools 
 Repeatability: Allows a check for repeatability within a requested time frame for a stream. The 

Repeatability option will only be active if you are logged in as supervisor and you are connected to 
at least one STAR Server. See section 3.11 for more information on repeatability. 

 Reprocessing: Allows the user to reprocess a chromatogram in the chart viewing area by changing 
current TCF setting in method. The Reprocessing option will only be active if you are logged in as 
supervisor. 

 Clear Event Log: Empties the current Live event log 
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 PGC5000 Config Converter: Allows the user to update PGC5000 Generation 1 version 3 files to run 
version 4 

 PGC5000 Generation Converter: Allows the user to update a PGC5000 Generation 1 to a PGC5000 
Generation 2 analyzer 

 Get all Recovery Media: Creates a recovery media for all PGC5000 Generation 1 version 4, and 
PGC5000 Generation 2 analyzers 

 Export Device List: Exports current device list to .csv file in a user-specified location. The device 
list will contain the name, type, IP addresses, and version of all devices in the tree view. 

 Options: Allows modification of properties of Plant View, Charts, TCFs, and Peak Data Records. 
Changes will not take effect until a new chromatogram/trend is opened. 

3.2 OPC Concentrator 
The OPC Concentrator collects data from any Data Access 2.0 compliant OPC server. The OPC 
Concentrator runs as a Windows Service, and when activated as described in section 2.4, the OPC 
Concentrator will appear in the Devices tab of the STAR Client (see Figure 3-3). 

Figure 3-3: OPC Concentrator in Devices Tab 

 
The STAR Client can be used to view the stored data, and it acts as the configuration tool. To 
configure the OPC Concentrator: 

1. Right click on the OPC Concentrator. The menu shown in Figure 3-4 appears. 

Figure 3-4: OPC Concentrator Menu 

 
2. To choose the STAR Server to be used for storing the data, select Add/Modify STAR Server 

and click on the desired server. 

3. Enter the name of the STAR Server and click OK. The result will give you another level in the 
tree view (see Figure 3-5). 

Figure 3-5: OPC Concentrator Sub-level 

 
4. To add an OPC Server, right click on the STAR Server. The Add OPC Server screen appears (see 

Figure 3-6). 

Figure 3-6: Add OPC Server Screen 

DGKS8082\VS-S
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5. Click Add OPC Server. This will allow you to choose the machine and OPC Server you wish to 
use to retrieve data. 

6. In the DigAddOPCServer screen, enter the machine name or IP address of the machine hosting 
the OPC Server(s). 

7. Select the OPC Server and click OK (see Figure 3-7). 

Figure 3-7: DigAddOPCServer Screen 

 
This will result in another level in the tree view as seen in Figure 3-8. 

Figure 3-8: Third Level in OPC Concentrator tree view 

 
8. Right click on the OPC Server (e.g. Optima.OPCService) item to select the Set Frequency and 

Delay screen (see Figure 3-9). From this screen you can set the frequency of updates and the 
delay for restart if the OPC Server is no longer reachable (machine rebooted, network 
disconnect, etc.). 

Figure 3-9: Set Frequency and Delay Screen 
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9. Expand the OPC Server to see the OPC tags available for subscription to the STAR Server 
(Figure 3-10). 

Figure 3-10: Available OPC Tags 

 
10. To select an OPC tag to be stored in the OPC Server, right click on the OPC item. A dialog box 

appears with the Add Tag To Concentrator option (see Figure 3-11). 

Figure 3-11: OPC tag dialog box 

 
To verify the action and to find the OPC tags being stored in the STAR Server, look for the green 
checkmark through the OPC item Icon, as seen in Figure 3-12. 

Figure 3-12: OPC tags stored 

 

3.2.1 Help 
 STAR DMS Guide: launches the STAR DMS Operating Instructions 
 About STAR Client: displays the current version of client software being used 
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3.3 Treeview 
By default, the treeview pane is unpinned in the upper left corner of STAR Client. When you select 
treeview, a content pane appears, docked on the left side of the STAR Client by default (see Figure 
3-13). This pane, with its sub-items, provides access to analytical functions and features. 

Figure 3-13: Treeview Structure 

Window
Position

 
On the Treeview pane, two tabs, a Filter icon, and a Window Position icon appear: 

 Devices tab: displays a list of devices and applications currently participating in the STAR DMS.  
Figure 3-13 shows this tab and section 3.4 provides detailed information on the Devices tab.  
Devices are grouped by their device type in a folder structure. If there is a red “X” over the icon 
and the device is flashing red, the device or application is no longer active. If the device or 
application has been removed from the STAR DMS, you can remove it with a context menu option. 

 STAR tab: displays a list of STAR server devices and applications reporting to the server. Each 
entry can be expanded to display its own group of streams and components. Section 3.5 provides 
detailed information on the STAR tab. 

 Filter icon: at the top left corner of the Treeview pane is used to filter the Treeview STAR tab (see 
Figure 3-14)  

Figure 3-14: Filter Icon 

 
When you click the Filter icon, the Filter Dialog box appears (see Figure 3-15). Select the desired data 
in the Filter dialog box and click OK. The Treeview will refresh and only the data types selected will be 
displayed in the Treeview STAR tab. If you select All, the Treeview STAR tab will contain data stored 
for all devices. 
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Figure 3-15: Filter Dialog Box 

 
 Window Position icon: displays a list of positions the user can utilize for the Treeview pane, 

including Floating, Dockable, Tabbed Document, and Auto Hide. Right click in the title bar to 
return from Floating to other options.  

3.4 Treeview: Devices tab 
The Devices tab shows all devices and applications currently participating in the STAR DMS. If a 
device is offline (powered off, or has a network issue), it will appear with a red “X” over the icon and 
will flash red. 

At the device type folder level 1, the PGC5000 and PGC5000 Generation 2 devices allow for the 
creation of a recovery media backup of all devices of its type. Right click and select Get All Recovery 
Media. Select the desired device and then click Accept. Browse to select the folder in which to save 
the current configuration. 

3.4.1 Context menu, various applications 
1. Open the Treeview. 

2. Click Devices. 

3. Click the desired folder. 

4. Right click on the desired device. 

5. The Devices dialog box shows the available options (see Figure 3-16). 
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Figure 3-16: Context Menu, Various Applications 

 
All devices have the following information:   

 Name of Device 
 Device Type 
 IP Address – Primary 
 IP Address – Secondary 
 Version 

3.4.2 Context menu, PGC5000 ver. 4 and PGC5000 Generation 2 
1. Open the Treeview. 

2. Click Devices. 

3. Click on the desired folder. 

4. Right click on the desired device. 

5. The Devices dialog box shows the available options (see Figure 3-16). 
 

3.4.3 Open a report directly from PGC5000 
To open a report from the Devices tab (PGC5000 only): 

1. Open the Treeview. 

2. Click Devices. 

3. Click on the desired folder. 

4. Right click on the desired device (PGC5000 or PGC5000 Generation 2). 
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IMPORTANT NOTE: This will open a context menu, which differs according to the devices and 
applications being used. All devices and application other than PGC5000 Version 4 and PGC5000 
Generation 2 analyzers have a shorter selection menu. See sections 3.4.1 and 3.4.2 for illustrations 
of these context menus. 

5. Click Retrieve Reports. This will retrieve all available reports directly from the device. 

 

IMPORTANT NOTE: For the PGC5000, it will provide 24 hours of reports. For the PGC5000 
Generation 2, a dialog box will appear and allow the user to select a time range up to seven days. 

6. Navigate down the tree to locate the desired report. 

7. There are two ways to retrieve a report. 

• Double-click on Report for two hours of reports. 
• Right-click on Report to open a dialog box. 

8. If you right-click on Report, a Report dialog box appears. 

a. Click Select Range and wait for the dialog box or click Quick Reports. 
b. When the Select Range dialog box appears, choose the desired range and click OK. 
c. Select the desired report. 
d. Right-click on Create New View to display a new view or click Add to Active View to 

overlay the new view onto an existing view. 
The chromatogram will appear on the screen in the viewing area. 

3.5 Treeview: STAR tab 
To open a report from the STAR tab: 

1. Open the Treeview. 

2. Select a STAR server. 

3. Connect if needed. 

4. From the STAR tab, select the desired analyzer (see Figure 3-17). This example shows 
PGC5000s, PGC2000s, and Multiwaves. 
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Figure 3-17: STAR Tab 

 
5. If the device is a PGC5000, select the schedule. 

6. Select the desired stream. 

7. Select the desired analysis. 

8. There are two ways to retrieve a report: 

a. Right click Report. This will retrieve all available reports (within the selected range) from 
the server. 

b. Double click on Report for two hours of reports. 
9. If you right-click on Report, a Report dialog box appears. 

a. Click Select Range and wait for the dialog box or click Quick Reports. 
b. When the Select Range dialog box appears, choose the desired range and click OK. 
c. Select the desired report. 
d. Right click Create New View or Add to Active View or double-click to create a new view. 

10. The chromatogram will appear on the screen (see Figure 3-18). 



30 | STAR DMS OI | 892J007MNAE 

Figure 3-18: Chromatogram Example 

 
 

3.6 Properties 
By default, the Properties pane is unpinned in the upper right corner of STAR Client. When you select 
Properties, a content pane appears, docked on the right side of the STAR Client by default (see Figure 
3-19). Changes to chart properties can be made from this pane. Any changes made will take 
immediate effect. 
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Figure 3-19: Properties 

 

3.7 PlantView 
The PlantView gives a graphical view of their plant’s control rooms and shelters. From the main menu, 
select Tools>Options. On the General tab (see Figure 3-20), configure the background for the 
PlantView, Control Room and Shelters by selecting the background using the Browse button. The 
background can be in most graphical formats (BMP, JPG, PNG). 
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Figure 3-20: Typical PlantView Screen 

 
Each STAR Client has a local PlantView. This PlantView can be customized for each STAR Client to 
contain devices needed for this STAR Client. Once the backgrounds have been chosen, add control 
rooms and shelters on the PlantView background as needed. To add devices/applications to the 
control rooms or shelters, either drag-and-drop the device onto its destination or use the Add to 
PlantView context menu option from the Treeview Device tab. Once the devices/applications are in the 
control rooms or shelters, the same context menu items are available on the Treeview Device tab. 

3.8 Live 
When you select Live, the current event log appears for viewing only (see Figure 3-21). Click on 
another function to close the event log. 
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Figure 3-21: STAR Client showing Event Log 

 

3.9 Viewing area 
When the viewing area has a PGC5000 analyzer report selected at the top of the screen, subtabs at 
the bottom of the screen show: Report, Alarms, Peak Data, TCFs, and Components. These are 
described in the following paragraphs. If you have multiple detectors, you can open each one 
separately from its subtab. 

3.9.1 Report 
When you click on the PGC5000 report subtab, an analysis report will appear across the bottom of the 
screen (see Figure 3-22). This is the standard analysis report. Clicking on the viewing area will close 
this report. 
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Figure 3-22: Standard Analysis Report 

 
To access a more detailed report: 

1. Open the Properties view (see Figure 3-23). 

Figure 3-23: Properties View 

 
2. Select the desired report. 

3. Check Raw Report. 

4. Click on the Report subtab and the raw report will appear (see Figure 3-24). 
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Figure 3-24: Raw Analysis Report 

 
5. Click the viewing area to close this report. 

3.9.2 Alarms 
When you click on the Alarms subtab, an alarms report will appear across the bottom of the screen 
(see Figure 3-25). The Alarms subtab is not available on some instruments. 

Figure 3-25: Alarms Report 

 
Click the viewing area to close this report. 

3.9.3 Peak data 
When you click on the Peak Data subtab, a Peak Data report will appear across the bottom of the 
screen (see Figure 3-26). 
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Figure 3-26: Peak Data Report 

 
When you open a specific column in this report (apply a check mark), that column’s information will 
appear in the appropriate boxes in the viewing area if you have the Show Peak Data box checked in 
the Properties window. 

Click on the viewing area to close this report. 

3.9.4 TCFs 
When you click on the TCFs subtab, a TCF report will appear across the bottom of the screen (see 
Figure 3-27). 

Figure 3-27: TCF Report 

 
When you open a specific column in this report (apply a check mark), that column’s information will 
appear in the appropriate boxes in the viewing area if you have the Show TCFs box checked in the 
Properties window. 

Click on the viewing area to close this report. 

3.9.5 Components 
When you click on the Components subtab, a Components report will appear across the bottom of the 
screen (see Figure 3-28). 
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Figure 3-28: Components Report 

 
When you open a specific column in this report (apply a check mark), that column’s information will 
appear in the appropriate boxes in the viewing area. 

Click on the viewing area to close this report. 

3.10 Viewing Area Tabs 
When you have multiple tabs open in the viewing area, you can split the windows vertically or 
horizontally. Right click on a tab and select the following options: Close, Close All But This, Tabbed 
Document, New horizontal Tab Group, or New Vertical Tab Group. 

Figure 3-29: Viewing options 

 
 Close – closes the current tab 
 Close All But This –closes all tabs except the current one 
 Tabbed Document – indicates that the tab is a single document, not part of a tabbed group 
 New Horizontal Group – moves the tab to a separate tabbed Horizontal group 
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Figure 3-30: Horizontal group view 

 
 New Vertical Group - moves the tab to a separate tabbed Vertical group 
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Figure 3-31: Vertical group view 

 
 

3.11 Repeatability 
Repeatability is only available if a STAR Server exists in the STAR DMS. 

To use the Repeatability feature, you must have Supervisor access. 

1. At the top left of the screen, click File. 

2. Click Login from the drop-down menu (see Figure 3-32). 
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Figure 3-32: Login Dialog Box 

 
3. Enter the User and Password information. 

4. Click Tools at the top of the screen. 

5. Click Repeatability. 

6. The Repeatability View dialog box appears with devices that are currently searching for the 
Repeatability criteria. These devices and streams will stay populated in the Repeatability View 
dialog box until they are removed by the user. To remove a current Repeatability request from 
the dialog box, select the device you want to remove from the list and select Stop on the right 
side of the Repeatability View dialog box. 

7. To add a new device to the Repeatability View dialog box, click Add at the right side of the 
Repeatability View dialog box (see Figure 3-33). 
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Figure 3-33: Repeatability View Dialog Box 

 
8. On the Repeatability Criteria dialog box (see Figure 3-34), enter the desired information as 

explained below. 

Figure 3-34: Repeatability Criteria Dialog Box 

 
9. Select the STAR Server and Device: if the Device has a stream associated with it, select 

Stream. 

10. Select the Component and desired value. 
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11. Select the Acceptance Criteria: 

• % Full Scale – uses the input Low and High range of the component, based on their unit of 
measure, and compares against trended data in the +/- limit percentage defined in search 
criteria 

• # of Standard Deviation – uses mean average of data points and allows certain number of 
step outs/rejections about the mean 

• % of Standard Deviation – uses mean average of data points and allows certain 
percentage of drifting from mean data points 

12. Select the Rejection Rules: 

• Three Sigma – one point in trend falls beyond the Upper or Lower trend limits 
• Three Successive Points – two out of three consecutive points fall on the same side of the 

centerline at Uppermost or Lowermost trend limits 
• Five Successive Points – four out of five consecutive points fall on the same side of the 

centerline of trend that is >50% of trend limits 
• Run – seven consecutive points fall on one side of the centerline 
• Trend – seven consecutive points either increase or decrease 
• Zig Zag – fourteen successive points alternate in an up-down pattern 
• Hugging – fifteen successive points fall on one side of centerline 

13. Select Add. 

14. In the Start Search box, select the Start Time. 

15. Select the Min. Acceptance Time. 

16. If the Repeatability needs to continuously search for the best time (defined by the Minimum 
Acceptance time), leave the Define End Search box unchecked. This will allow Repeatability to 
continuously look for the best time frame defined by the Minimum Acceptance time. If you have 
a specific time that the Repeatability needs to fall within, you must select a Start and End 
Search time. 

17. Select Send. 

18. The device with customized search criteria should now appear in the Repeatability View 
window. If the Repeatability trend is within specifications, the Repeatability Found column will 
display a TRUE message. If the Repeatability trend was rejected by one of the rules of 
Acceptance Criteria, the Repeatability Found column will display a FALSE message. Select 
Refresh to update the status of the Repeatability search. 

3.12 Groups 
The Groups feature allows you to add analyzers and devices associated to a STAR Server into groups.  
These associated analyzers and devices appear under a connected STAR Server under the STAR tab in 
the Treeview. Each STAR Server connected to the STAR Client contains a Groups folder. It is within 
this folder that you can add a custom group folder containing analyzer(s) that are associated with the 
given STAR Server. The Groups folder is automatically generated by the STAR Client in the STAR 
Server’s Treeview and will always appear at the top of the list. To see it, expand a STAR Server that is 
connect to the STAR Client. You can create new groups and access existing groups. 

To create a group: 

1. On the STAR Client, open the Treeview pane. 

2. Select STAR in the Treeview pane. 

3. Select Groups. 

4. Right click to display a dialog box. 

5. Select Add Group from the dialog box. 

6. From the Rename dialog box, insert a name and click OK. 

7. From the device list in the Treeview pane, right click on the desired device(s). 

8. In the dialog box, right click Add to Group. 

9. Select the group to use. 

To view an existing group: 

1. On the STAR Client, open the Treeview pane. 
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2. Select STAR in the Treeview pane. 

3. Select Groups. 

4. Click Groups to display the existing groups. 

5. Click on the desired group to use. 

To add an analyzer to a group: 

1. Right click on the analyzer you wish to add to a group. 

2. Click Add to Group. 

3. Click on the desired group. 

To remove an analyzer from a group: 

1. Expand a group folder. 

2. Right click on the analyzer you wish to remove from the group. 

3. Click Remove From Group. 

4. Click Yes to remove the analyzer or click No to retain it. 

To remove all analyzers from a group: 

1. Right click the desired group folder. 

2. Click Remove All From Group. 

3. Click Yes to remove all analyzers or click No to retain them. 

To delete a group folder: 

1. Right click the group folder you want to delete. 

2. Click Delete Group Folder. 

3. Click Yes to remove the Group folder or click No to retain it. 

To rename a group folder: 

1. Right click the desired group folder. 

2. Click Rename Group. 

3. Enter the new name for the folder and click OK. 

3.13 Availability 
Availability is accessed from the STAR Client, but the STAR DMS must have STAR Server for this 
function to operate. Availability is set to one week of data by default, but the user can select other 
optional time periods. The Availability function operates only with PGC5000 Generation 2 analyzers 
with report and status subscriptions. It is based on configured schedules. The Availability chart shows 
cumulative availability if more than one schedule is selected. Availability is expressed both in 
percentage and in hours. 

Availability has three functional levels: Device, STAR Server, and Group. These levels, which will be 
explained later in this section, are defined as follows: 

 Device: a PGC5000 Generation 2 Analyzer 
 Server: all devices on a connected STAR Server (STAR Client can accommodate up to four STAR 

Servers) 
 Group: a selected group of devices 

3.13.1 Accessing availability: device 
1. On the STAR Client, open the Treeview pane. 

2. Select STAR in the Treeview pane. 

3. Select the desired connected server. 

4. Select the device. 

5. Right click to display a dialog box. 
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6. Select View Availability from the dialog box and the Availability screen will appear (see Figure 
3-35). This chart will show the availability for the last week, by default. At the bottom of the 
screen are the categories applying to the availability pie chart. 

Figure 3-35: Availability Screen 

 
The categories, which define the various sectors within the availability chart, are as follows: 

 Unknown—percentage/time for which there is no data for this device 
 Online Valid—percentage/time logging valid data from the device 
 Online Invalid—percentage/time logging data that invalidated at the device 
 Maintenance—percentage/time spent in maintenance 
 Calibration—percentage/time spent in calibration 
 Validation—percentage/time spent in validation 
 Offline—percentage/time the schedule is not running 
Note the three subtabs at the bottom of the screen: Range, Schedule, and Alarms. 

The Range subtab allows you to select a different range instead of the default range (see Figure 
3-36). 
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Figure 3-36: Availability Screen showing range selection 

 
You can either select a preset range or enter a range manually. After you enter the desired range, 
click Refresh. 

You can select different schedules to view by selecting the Schedule subtab (see Figure 3-37). There 
can be up to 12 schedules defined in a PGC5000 Generation 2 analyzer. When the schedule view 
appears, select the desired schedule(s) by ensuring there is a check mark in the Display column. To 
eliminate a schedule from the chart, clear its check mark in the Display column. 

Figure 3-37: Availability Screen, showing schedule selection 

 
Alarms data will only appear when there are active alarms that have been configured in scope to 
invalidate an analysis run. When you select the Alarms subtab, the Alarms listing appears at the 
bottom of the screen, showing all active alarms (see Figure 3-38). 
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Figure 3-38: Availability Screen, showing alarms selection 

 
To display the report associated with a given alarm, click Show Report. 

3.13.2 Accessing availability: server 
1. On the STAR Client, open the Treeview pane. 

2. Select STAR in the Treeview pane. 

3. Select the desired connected server. 

4. Right click to display a dialog box. 

5. Select View Availability from the dialog box and the Availability screen will appear (see Figure 
3-35). 

6. From the Select Analyzer dialog box, select the desired device(s) and click OK. 

7. Follow the Range, Schedule, and Alarms steps in section 3.13.1 . 

3.13.3 Accessing availability:  groups 
From the Groups folder, you can access availability by following these steps: 

1. Select the desired group. 

2. Right click to display a dialog box. 

3. Select View Availability and the Availability screen will appear (see Figure 3-35). 

4. Follow the Range, Schedule, and Alarms steps in section 3.13.1.  

3.14 Maintenance Logbook 
The Maintenance Logbook allows you to track the activity of the associated device. All information in 
the Logbook must be entered by the user. You can enter maintenance already performed, 
maintenance in progress, maintenance required, and notes for future reference. 

3.14.1 Accessing maintenance logbook: device 
1. On the STAR Client, open the Treeview pane. 

2. Select STAR in the Treeview pane. 

3. Select the desired connected server. 

4. Select the device. 
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5. Right click to display a dialog box. 

6. Select View Logbook from the dialog box and the Logbook will appear. 

Figure 3-39: Maintenance Logbook 

 
The Logbook entries show the information for each entry, as entered by the user. The buttons on the 
right are used as follows: 

 Add: click to enter information. 
 Edit: can only be accessed by a supervisor, who can edit the information on the selected line. 
 Refresh: if some information has been added or edited, this will update the log entry. 
 View: brings up the Info form, which is the same as that for Add. 
 Export: allows you to export the entire logbook to a .csv file. 
 Print: allows you to print the entire logbook to a user-selected printer. 

3.14.2 Accessing maintenance logbook: groups 
1. On the STAR Client, open the Treeview pane. 

2. Select STAR in the Treeview pane. 

3. Select Groups. 

4. Click Groups to display the existing groups. 

5. Click on the desired group to use. 

6. Select View Logbook from the dialog box and the Logbook will appear. 

3.14.3 Entering information 
To add information to the Logbook, click Add and enter information on the Add Entry screen as 
follows (see Figure 3-40). This screen has four sections: Problem Description, Problem Type, 
Resolution, and Associated Files. 

Figure 3-40: Add Entry Dialog Box 
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Problem Description: 

 Problem Occurred: insert the date the problem occurred 
 User: enter the user’s name 
 Problem Description: enter a brief statement of the problem 
 Work Order: enter the work order number, if applicable 
 Warranty: click True or False, as applicable 
Problem Type: 

 Problem Type: click the appropriate box and select the location of the problem. The items in the 
location box will change according to the problem type selected. 

Resolution: 

 Problem Resolved: enter the date the problem was resolved 
 Repair Made: enter a brief statement of the repairs performed 
 Parts Required: List the parts used 
 Tools Required: List the tools used in the repair 
 Time to repair: enter the time needed to complete the repairs in hours and minutes. 
Associated Files 

 Associated Files: add any files of importance to this problem. You can only add files that have 
been saved in the STAR Server for the device for which you are creating the Maintenance Log. 

When you have completed all information on the Add Entry screen, click Submit. 

3.15 Barometric Pressure Compensation 
The STAR Server has built-in Barometric pressure compensation when needed using the iOmega iBTX-
D meter. It is din rail mounted and can be setup at a customer site preferably near the analyzer 
shelter. This option can be used for any analyzer that is open to atmospheric pressure. This function 
will compensate for barometric pressure changes during the time of the displayed concentration trend. 

With a trend open, right click and select “Barometric pressure”. The following dialog will appear. 

 
The fields to be configured are as follows: 

• “Start Time:” comes from the trend parameters. 

• “End Time:” comes from the trend parameters. 

• “Exponent:” should remain at 1.0. However, under certain circumstances you may want to 
change the exponent. 

• “Stream:” will be the calibration stream to determine the barometric pressure at the time of 
calibration. 

• “Analysis:” will be the analysis ran on the calibration stream at the time of calibration. 
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• “Report:” will be the calibration reports from the calibration stream at the time of calibration. 

• “Use Manual” is used when there are no calibration analysis reports that are present or too old 
to be relevant. This allows for the user to select a date and time for the barometric pressure 
at the time of calibration. 

The following equation is used for barometric pressure compensation: 

Cc  = Cuc * ( Pc / Pa )^x 

where 

Cc  = Corrected concentration for barometric pressure 

Cuc = Concentration straight from the analyzer (uncorrected) 

Pc = Barometric pressure at the time of calibration (obviously this will be a different time 
stamp for each GC) 

Pa = Barometric pressure at the start of the analysis cycle (Within 5 minutes) 

x    = Exponent factor:  Used if barometric pressure is determined to be non-linear 

 

4 STAR server 
4.1 Introduction 
The STAR Server is a storage device for storing reports, report data, and device status from multiple 
devices (listed below) for a minimum of 30 days. There are two levels of capacity for the STAR 
Server: 1 to 15 devices, or 1 to 50 devices. The STAR Server comes as an appliance: a Dell® rack-
mounted computer with the factory-installed STAR server.  

The STAR Server supports:  

 PGC5000 family  
 PGC2000/3100  
 PGC1000 
 Multiwave analyzer (MW)  
 Reid Vaper Pressure analyzer (RVP) 
 Data Access 2.0 OPC Servers 
For the PGC5000 Generation 1 Version 4, PGC5000 Generation 2, PGC2000, MW and RVP devices, 
simply add a STAR Server to the subscriber list in the device and the reports will be sent to the STAR 
Server at the end of the next analysis cycle. For other subscription types, refer to the Subscriber Lists 
in section 2.2. 

The STAR Server can be configured using the Configuration Manager. The Configuration Manager is 
also used to perform several maintenance tasks required for modifying and maintaining the STAR 
Server. Once it is initially configured, the main portal to the STAR Server is through the STAR Client.  
See the section 3, STAR Client, for usage and functionality. 

4.2 Configuration manager 
The Configuration Manager can be launched by double clicking the 
C:\ABB\Analytics\STAR\Server\Configuration Manager.exe file (see Figure 4-1). This screen has two 
menu options at the top of the screen and four sections on the screen. 
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Figure 4-1: STAR Server Configuration Manager 

 

4.2.1 Menu options 
The two menu options at the top of the Configuration Manager screen are Tools and Help. 

Tools: has several features for modifying the STAR Server and providing diagnostic information for 
service engineers (see Figure 4-2). 

Figure 4-2: Tools Dialog Box 

 
 Export System Information: collects system information for the licensing feature of the STAR 

Server. If the user changes Mother Board, NIC, or SQL Server on the STAR Server, a new license 
file will need to be generated by ABB Service.   
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 Import License File: allows the user to load the license file into the STAR Server. When ABB 
Service generates a new License File, the user installing the license will need to select the License 
File. 

 Update Computer Name: If the name of the device where STAR Server is installed changes, select 
this option to change the name throughout the STAR Server. If this is not done, the STAR Server 
will not store data from the analyzers. 

 Perform Database Upgrade: will typically be done by the installer during an upgrade procedure. 
However, if needed, the upgrade to the Database can be done by selecting this option. 

 Resurrect Database: Use this option to delete the existing Database and install a blank Database. 
This should only be done as a last resort or if instructed to do so by an ABB Service Engineer. 

 Dump Diagnostics Log: will create a DiagnosticsRecords.CSV file in the 
C:\ABB\Analytics\STAR\Server\ folder. This file will contain diagnostic information needed by 
support personnel to troubleshoot issues with the STAR Server. Support personnel will ask for this 
file if needed. 

 Restore Factory Defaults: resets all configuration options to factory defaults 
Help: displays the version information for the Configuration Manager. 

4.2.2 Screen sections 
The four sections of the Configuration Manager screen are: Network IP Address(es), Logging, and 
Device and Port Configuration, and License Information. 

Network IP Address(es): is used to enter the Primary and Secondary IP Addresses. The user is 
presented a list of configured IP addresses for the server. Once the IP Addresses have been chosen, 
click Apply to save the information. 

Logging: is used for troubleshooting the STAR Server. 

 Log Level: The default Log Level is set to (1) Errors. Figure 4-3 shows the available choices. 
Figure 4-3: Log Level Dialog Box 

 
 Log Hours: is a slider to define how much logging, in hours, of the diagnostic messages is saved. 

This is limited based on the amount of disk space that can be consumed during a troubleshooting 
session. It is set to 72 hours by default. The range is 0 to 168 hours. 

 Capture TCP Blobs and Capture Pipe Blobs should never be enabled unless directed to do so by 
ABB Service Engineers. 

 Analyzers button (see Figure 4-1) will call up the dialog box shown in Figure 4-4. Type the name 
of the device to which you want to save additional data and select the Log Level. This allows the 
STAR Server to save additional log information for specific analyzer(s). 

Figure 4-4: Analyzer Log Levels 

 
When you have completed the entries in the Logging section, click Apply to save them. 
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License Information: This section is used to display the license information for the STAR Server. 
The Database and License file should match the Level (15 or 50) and the Feature Set of the STAR 
Server. If these do not match, contact ABB Service. The Database section will also display the number 
of licenses that are currently consumed by the STAR Server. If this number matches the License 
Level, then the STAR Server cannot accept new devices. 

Device and Port Configuration: are configured by default. Ports can be modified by the user. If a 
barometric pressure meter was purchased, the IP address and frequency of the polls can be 
configured in the Barometric Pressure Meter subsection. The default IP Address for the Barometric 
Pressure Meter is 192.168.0.225. 

4.3 Connecting to a STAR Server 
For a STAR Client to connect to a STAR Server, right click on the STAR Server entry in the Treeview 
pane and select Connect from the context menu (see Figure 4-5). 

Figure 4-5: Context Menu 

 
Once selected, Connect will be replaced in the Context menu by Disconnect. You can disconnect by 
selecting Disconnect in this menu. 

A STAR Client can be connected to as many as four STAR Servers at a time. 

 

IMPORTANT NOTE: The STAR Server cannot be run on the same server computer as the STAR 
Gateway if any legacy devices are present in the STAR System. If the STAR System is composed of 
only PGC5000 version 4 or higher analyzers, the STAR Server and STAR Gateway can reside on the 
same server platform.   

 

5 Reporter 
The Reporter displays, stores and prints event messages and analysis reports. The Reporter can be 
run as an application or as a Windows Service. If run as an application, it can be accessed from the 
desktop or from the STAR Client (see below for instructions). If run as a Windows Service, enable the 
Vista Reporter Windows Service. The Vista Reporter Windows Service is disabled by default. You must 
be an Administrator on the machine to enable the Windows Service.  

5.1 Access from the desktop 
To access the Reporter from the desktop: 

1. Click on the ABB STAR folder on the desktop. 

2. Select the Reporter shortcut. The Report Device - Reporter window appears (see Figure 5-1). 
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Figure 5-1: Reporter Window 

Message View File Status View
 

5.2 Access from the STAR client 
To access the Reporter from the STAR Client: 

1. Click Classic Applications on the Client menu bar. 

2. Select Reporter and click Launch. The Report Device - Reporter window appears (see Figure 
5-1). 

5.3 Reporter window 
The Report Device - Reporter window (see Figure 5-1) consists of a Menu Bar across the top, a 
Message View on the left side, and a File Status View on the right side. 

 The Message View contains a list of the reports and events occurring while the Reporter is 
running. 

 The File Status View provides a list of files, together with the status of each file. 
 The items in the Menu Bar have submenus to help divide the various tasks to be done, as 

explained in the following sections. 

 

IMPORTANT NOTE: If running the Reporter as a Windows Service, the Vista Reporter RUI 
(VnRUIrptr.exe) will call up the Reporter window. 

5.3.1 File 
The File menu enables you to exit the Reporter. 

5.3.2 View 
The View menu lists the various tools you can use in Reporter: Toolbar, Status Bar, Time Stamp, 
Originator, Options, Controls, and Local Setup. You can also configure reports from the View menu.  

5.3.2.1 Toolbar 

To display the toolbar: 

1. Click View on the menu bar. 

2. Click Toolbar to turn it ON (check mark appears). The toolbar will appear at the top of the 
screen. 

5.3.2.2 Status bar 

To display the status bar: 



54 | STAR DMS OI | 892J007MNAE 

1. Click View on the menu bar. 

2. Click the Status Bar to turn it ON (check mark appears). The status bar will appear at the 
bottom of the screen. 

5.3.2.3 Timestamp 

You can configure reports to contain the date and time at the top of each report and to identify the 
device providing the data for each report. 

To enable the timestamp functions: 

1. Click View on the menu bar. 

2. Click Timestamp to turn it ON (check mark appears). 

5.3.2.4 Originator 

To identify the device providing the data for each report: 

1. Click View on the menu bar. 

2. Click Originator to turn it ON (check mark appears). 

5.3.2.5 Options: report colors 

The Report Colors function enables the user to change the colors for different report types. To access 
Report Colors: 

1. Click View on the menu bar. 

2. Select Options. 

3. Select Report Colors. 

4. In the Report Colors dialog box (see Figure 5-2), select the desired colors in the boxes next to 
each report type. 

Figure 5-2: Report Colors Dialog Box 

 
5. When the changes are complete, click OK to save, or click Cancel to retain the previous 

settings. 

6. To revert to the default colors, click Restore Defaults and then click OK. 

5.3.2.6 Options: analyzer reports 

The Analyzer Reports function allows the user to add, edit, or remove configured analyzers. 

1. Click View on the menu bar. 

2. Select Options. 

3. Select Analyzer Reports. 

To add an analyzer: 

1. Select Add. The Add Analyzer dialog box appears. 

2. Enter the necessary data. 
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3. Click OK to add this analyzer to the list, or click Cancel. 

To edit an analyzer: 

1. Select the desired analyzer from the Configured Analyzers box. 

2. Click Edit. 

3. On the next screen, enter the desired changes and click OK to save the changes, or click 
Cancel to retain the previous values. 

To remove an analyzer from the list: 

1. Select the desired analyzer from the Configured Analyzers’ box. 

2. Click Remove. The analyzer will be removed from the list. 

5.3.2.7 Options: system reports 

The System Reports function allows the user to change a system name or to clear the entries in a 
selected file. 

1. Click View on the menu bar. 

2. Select Options. 

3. Select System Reports. 

To change a system name: 

1. In the System Event File dialog box, edit the name shown. 

2. Click OK. The revised name is entered into the list. 

To clear all entries in a system file: 

1. Note the file name shown in the dialog box. 

2. Click Clear File. All entries in that file will be removed. (The system file remains to collect new 
data.) 

5.3.2.8 Controls: system event file 

The event files are circular. When the maximum number of files has been reached, a new file forces 
the oldest file to be erased. The report generation function in Reporter converts the circular event file 
to a plain text file that can be viewed and printed with any text editor (such as NotePad or WordPad). 

Choosing System Event File enables or disables Reporter to save System Event messages. This file is 
a circular binary file with up to 5000 entries. System Event messages include application errors and 
system events. 

To enable System Event File: 

1. Click View on the menu bar. 

2. From Controls, click System Event File to turn it ON (check mark appears). 

5.3.2.9 Controls: analyzer event files 

The event files are circular. When the maximum number of files has been reached, a new file forces 
the oldest file to be erased. The report generation function in Reporter converts the circular event file 
to a plain text file that can be viewed and printed with any text editor (such as NotePad or WordPad). 

Choosing Analyzer Event Files enables or disables Reporter to save Analyzer Event messages. Since 
this is a global choice, enabling the feature will enable all Analyzer Event files. You cannot select 
individual files from this menu item. Each Analyzer Event file is a circular binary file with up to 5000 
entries. 

To enable Analyzer Event Files: 

1. Click View on the menu bar. 

2. From Controls, click Analyzer Event Files to turn it ON (check mark appears). 

5.3.2.10 Controls: analyzer results files 

Choosing Analyzer Results Files enables or disables Reporter to save Analyzer Results files. Since this 
is a global choice, enabling the feature will enable all Analyzer Results files. You cannot select 
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individual files from this menu item. Each Analyzer Results file is a plain text file with a user-defined 
maximum size. Analyzer Results files include analysis, benchmark, and calibration results. 

To enable Analyzer Results Files: 

1. Click View on the menu bar. 

2. From Controls, click Analyzer Results Files to turn it ON (check mark appears). 

5.3.2.11 Controls: printer 

Reporter will print to the selected Windows default printer. It will print either all files or only those files 
selected by the user. 

To enable printing: 

1. Click View on the menu bar. 

2. From Controls, click Printer to turn it ON (check mark appears). 

5.3.2.12 Local setup 

To perform Local Setup: 

1. Click View on the menu bar. 

2. Select Local Setup. 

3. On the Local Setup dialog box (see Figure 5-3), enter the appropriate information and click OK 
to save the data, or click Cancel. 

Figure 5-3: Local Setup Dialog Box 

 

5.3.3 Reports 
Three types of reports are supported: Analyzer Events, System Events, and Configuration. Event 
messages are stored in a circular binary format. Report generation for system and analyzer events 
creates ASCII plain text files with events numbered and stamped for time received and the originating 
device (if enabled). Report generation for configuration summarizes the Reporter configuration in an 
ASCII plain text file. 

5.3.3.1 Analyzer events report 

To create an Analyzer Events report: 

1. Click Reports on the menu bar. 

2. Select Analyzer Events and the Event Report Generation dialog box appears (see Figure 5-4). 
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Figure 5-4: Event Report Generation Dialog Box 

 
3. Select the desired source filename from the list of available files. 

4. Enter a filename for the destination file. 

5. Click OK to generate the report or click Cancel. 

5.3.3.2 System events report 

To create a System Events report: 

1. Click Reports on the menu bar. 

2. Select System Events. The Event Report Generation dialog box appears (see Figure 5-4). 

3. Select the desired source filename from the list of available files. 

4. Enter a filename for the destination file. 

5. Click OK to generate the report or click Cancel. 

5.3.3.3 Configuration report 

To create a Configuration report: 

1. Click Reports on the menu bar. 

2. Select Configuration. The Configuration Report Generator dialog box appears (see Figure 
5-5). 

Figure 5-5: Configuration Report Generator Window 

 
3. Enter a filename for the configuration file. 

4. Click OK to generate the configuration report or click Cancel. 

 

6 Multiwave RUI 
6.1 Functional description 
The Multiwave Remote User Interface (RUI) provides remote access across the network between a 
specific software application and the analytical device. The RUI window initially shows two items on 
the menu bar: File and Help. 

6.2 Launch a Multiwave analyzer 
To launch a Multiwave RUI from the STAR Client: 

1. Open the Treeview. 

2. Click Devices. 

3. From the device list, double-click on the desired Multiwave. The Multiwave status display will 
appear (see Figure 6-1). 
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Figure 6-1: Multiwave Status Display Screen 

Status Pane Alarm Pane

Report Pane

SQC Pane

 
This screen displays data in four panes which function as follows: 

 Status Pane: displays the current operating status of the remote Multiwave; this pane emulates 
the screen of the remote analyzer 

 Alarm Pane: displays the same alarm data as the remote analyzer 
 SQC Pane: displays up to eight sets of statistical data 
 Report Pane: displays the selected report 
The title bar identifies the specific device to which the RUI has connected. 

6.3 Loading tables 
Before you can view or work with analytical tables, they must be loaded into the RUI. To load tables: 

1. Click File at the menu bar. 

2. Click Load Tbls. 

3. On the Multiwave Setup dialog box (see Figure 6-2), select the location from which to restore 
the tables (Remote RAM refers to MW RAM; Local Disk File refers to PC storage). 

Figure 6-2: Loading MW Tables Dialog Box 

 
4. Click OK to load the tables. 
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6.4 Saving tables 
Tables can be saved for future reference. To save tables: 

1. Click File at the menu bar. 

2. Click Save Tbls. 

3. On the Multiwave Setup dialog box (see Figure 6-3), select the location to which you want to 
save the tables (Remote RAM refers to MW RAM; Local Disk File refers to PC storage). 

Figure 6-3: Saving MW Tables Dialog Box 

 

 

NOTICE – Loss of data. When you click OK to save tables to Remote RAM, this action 
overwrites the existing tables on the Remote RAM. 

4. Click OK to save the tables. 

6.5 Printing tables 
You can print all analytical tables, or you can specify types of tables to print. To print tables: 

1. Click File at the menu bar. 

2. Click Print Tbls. 

3. When the Print dialog box appears (see Figure 6-4), verify the printer name and select the print 
range and number of copies to print. 

Figure 6-4: MW Print Dialog Box 

 
4. Click OK to print the tables. 
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6.6 Printing reports 
You can print all analytical reports, or you can specify types of reports to print. To print reports: 

1. Click File at the menu bar. 

2. Click Print Report. 

3. When the Print dialog box appears (see Figure 6-4), verify the printer name and select the print 
range and number of copies to print. 

4. Click OK to print the reports. 

6.7 Multiwave offline or online 
To take the Multiwave offline: 

1. Click Control at the menu bar. 

2. Click Go Off-Line. 

3. The Verify Action dialog box appears with the question: “Take the Multiwave Off-line?” 

4. Click Yes to go off-line or click No to stay on-line. 

To put the Multiwave online: 

1. Click Control at the menu bar. 

2. Click Go On-Line. 

3. The Verify Action dialog box appears with the question: “Put the Multiwave On-line?” 

4. Click Yes to go on-line or click No to stay off-line. 

6.8 Analyzer setup 
This screen enables you to access various Multiwave parameters and functions as described in the 
following paragraphs. 

1. Click Setup at the menu bar. 

2. Click Analyzer. 

3. When the Analyzer Setup screen appears (see Figure 6-5), change the desired parameter on 
the screen or click on the desired function box to access its screen. 

Figure 6-5: MW Analyzer Setup Screen 

 
4. If you changed a setting on the Analyzer Setup screen, click OK to save the change or click 

Cancel to retain the original value. 
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5. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

6. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.1 Operational limits 
1. From the Analyzer Setup screen, click Limits. 

2. When the Operational Limits screen appears (see Figure 6-6), select the desired parameters to 
change. 

Figure 6-6: MW Operational Limits Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.2 Analog outputs 
1. From the Analyzer Setup screen, click Analog Trends. 

2. When the Analog Outputs screen appears (see Figure 6-7), select the desired parameters to 
change. 

Figure 6-7: MW Analog Outputs Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 
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6.8.3 Factory settings: analysis 
1. From the Analyzer Setup screen, click Analysis in the Factory Settings box. 

2. When the Analysis Factory Settings screen appears (see Figure 6-8), select the desired 
parameters to change. 

Figure 6-8: MW Analysis Factory Settings Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.4 Factory settings: temperature and pressure 
1. From the Analyzer Setup screen, click Temp/Pressure in the Factory Settings box. 

2. When the Pressure & Temperature Control screen appears (see Figure 6-9), select the desired 
parameters to change. 
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Figure 6-9: MW Pressure & Temperature Control Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.5 Factory settings: alarms 
1. From the Analyzer Setup screen, click Alarms in the Factory Settings box. 

2. When the Alarm Configuration screen appears (see Figure 6-10), select the desired parameters 
to change. 

Figure 6-10: MW Alarm Configuration Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.6 Factory settings: digital inputs 
1. From the Analyzer Setup screen, click Input Definitions in the Factory Settings box. 

2. When the Digital Inputs screen appears (see Figure 6-11), select the desired parameters to 
change. 
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Figure 6-11: MW Digital Inputs Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.7 Factory settings: digital outputs 
1. From the Analyzer Setup screen, click Output Definitions in the Factory Settings box. 

2. When the Digital Outputs screen appears (see Figure 6-12), select the desired parameters to 
change. 

Figure 6-12: MW Digital Outputs Screen 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original values. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.8 Component setup 
1. Click Setup at the menu bar. 

2. Click Components. 

3. Click the desired component. 
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4. When the Component Description screen appears (see Figure 6-13), change the desired 
parameter or click on the desired function box to access its screen. 

Figure 6-13: Component Description 

 
5. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original value. 

6. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

7. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.9 Component limits 
1. From the Component Description screen, click Limits. 

2. When the Component Limits screen appears (see Figure 6-14), select the desire parameters to 
change. 

Figure 6-14: Components Limits 

 
3. When you have completed the changes, click OK to save the changes or click Cancel to retain 

the original value. 

4. If you click OK, the Tables Have Been Changed screen appears with the question: “Download 
Method to Multiwave?” 

5. Click Yes to save the changes to the Multiwave or click No to retain the original values. 

6.8.10 Subscriber setup 
1. Click Setup at the menu bar. 

2. Click Subscriber. 

3. When the Subscriber List screen appears (see Figure 6-15), you can modify or delete a specific 
subscriber, or add a new subscriber. 
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Figure 6-15: Subscriber List 

 
To modify a subscriber: 

1. Highlight the desired subscriber. 

2. Click Modify. 

3. When the Subscriber Entry screen appears (see Figure 6-16), enter the changes. 

4. Click OK to save the changes or click Cancel to retain the original values. 

5. When you return to the Subscriber List screen, you can make other changes as needed. 

Figure 6-16: Modify Subscriber Screen 

 
To delete a subscriber: 

1. Highlight the desired subscriber. 

2. Click Delete to remove the selected subscriber from the list. 

3. Click Update Table to delete the subscriber permanently or click Cancel to reinstate the 
subscriber. 
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To add a new subscriber: 

1. Click New on the Subscriber List screen. 

2. On the Subscriber Entry screen (see Figure 6-17), enter the desired information. 

3. Click OK. The new subscriber will appear on the Subscriber list. 

Figure 6-17: Adding a New Subscriber 

 
 

When you have completed all subscriber changes and entries, click Update Table to save the 
changes, or click Cancel to retain the original values. 

 

7 PGC5000 RUI 

 

NOTICE – Loss of data. The  is a quick delete button. Clicking  on any screen will 
immediately delete configuration or other settings. Be certain of the outcome desired before 
clicking .    

7.1 Functional description 
The RUI provides remote access across the network between a specific software application and the 
PGC5000. 

Figure 7-1 illustrates the basic PGC5000 Master Controller display layout and functionality. 
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Figure 7-1: Basic Analyzer Screen Layout 

12

34 5 67

About…        

 
1. Tabs – Select a tab using the cursor to navigate between system operational and configuration 

displays. 

2. Function Selector – displays buttons and action icons relative to the selected tab 

3. Subtab Display Area – provides specific information relating to the tab or subtab selected 

4. Subtabs –display additional information applicable for the main tab selected 

5. System Information Bar – displays current PGC5000 information 

6. Zoom Control – increases or decreases the scale of the display 

7. Status Indicator – indicates the status of the system 

• Green: normal 
• Yellow: warning 
• Red: alarm 
• Blue: information only 

7.1.1 Action icons 
Action icons represent action commands. Figure 7-2 shows the action icons with a brief description of 
each one. 
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Figure 7-2: Action Icons 

Power Failure Recovery Setup 
(Schedule Tab)
Maintenance Mode (Schedule 
Tab)

Schedule Abort (Schedule Tab)

Schedule Stop – Clears queue 
(Schedule Tab)
Save – Replaces saved 
information after editing

Save As – Saves as a new file

Add New – Creates new

Add – Adds existing item from 
library

Page Down; Line Down

Backup to USB Flash Drive 
(Setup Tab)

Restore Settings (Setup Tab)

Start (Schedule Tab)

Delete/Remove

Apply Response Factor (Setup 
Tab > Component)
Pause – Pauses schedule 
execution
Routing Table Configuration 
(Setup > Network Adapters)

Line Up; Page Up

Access Control List

Icon           Meaning/Function Icon           Meaning/Function

 
 

7.1.2 Function/navigation buttons 
Function/navigation buttons complete an action. Figure 7-3 shows the function/navigation buttons 
with a brief description of each one. 

Figure 7-3: Function/Navigation Buttons 

Add to a scope Status Tab)

Accept

Reset – Resets single indicator

Disconnect from remote Master 
Controller
Go Back – Returns to the last 
input
Shift Down – Virtual Keyboard 
Control
Login to a Master Controller

Start Schedule/Add to queue 
(Schedule Tab)

Abort – Cancel Entry

Reset – Reset all displayed indicators

Connect to a remote Master 
Controller

Next

Unblock a locked chromatogram

Lock a chromatogram

Icon Meaning/Function Icon Meaning/Function

 
 

7.1.3 System information bar 
The System Information Bar (see Figure 7-4), located along the bottom of the screen, gives a variety 
of information as noted in the following list. 

Figure 7-4: System Information Bar 

1

2

3

4

5
 

1. System Status Indicator – The color of the indicator reflects the overall health of the system. If 
the light is anything other than green, check the Status tab. The indicator colors signify the 
following: 
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• Green: Normal 
• Yellow: Warning 
• Red: Alarm 
• Blue: Information Only 

2. Network Connect Icon – allows connection to a Master Controller (from the RUI or from the 
Master Controller) to another Master Control by entry of an IP address. 

3. Security Login – options for user restriction enforcement 

4. Information Area – provides system messages 

5. Date and Time – shows date and time 

7.2 Naming conventions 
The following special characters may not be used in any software edit fields (e.g., component names, 
Master Controller name): 

.  Period 

/  Forward Slash 

\  Back Slash 

&  Ampersand 

˜  Tilde 

“  Double Quote (Quotation Mark) 

‘  Single Quote (Apostrophe) 

,  Comma 

?  Question Mark 

!  Exclamation Point 

@ At Symbol 

$  Dollar Sign 
 

 

IMPORTANT NOTE: When you are using the analyzer with a STAR server, all special characters 
other than “_” (underscore), “-” (minus or hyphen), or “+” (plus sign) will be converted to “_” 
(underscore) for storage in the STAR server. 

 

7.3 Connecting to a PGC5000 
To launch an RUI from the STAR Client: 

1. Right click on the Treeview. 

From the Function Selector, find the desired analyzer. 

2. To select the analyzer, do one of the following: 

• Double click on the analyzer (the RUI screen will appear, connected to the configured 
Primary IP Address). 

• Right click on the analyzer and click Launch RUI. 
• Select the Launch RUI options and chose to connect to the configured Primary or 

configured Secondary IP Address. 
For more information about PGC5000 RUI, see the Operating Instructions listed in the Additional 
information section.  

 

8 STAR Gateway (OPC server) 
The OPC Server application communicates with STAR devices to collect and distribute data that may 
be of interest to various OPC Clients. Paired with the appropriate clients, OPC can supply data to Data 
Historians, Control Systems, Monitor Displays, etc. Any OPC DA-2.0 Client application can access the 
data via OPC Tags from the OPC Server.  
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8.1 STAR Gateway installation 
The OPC Server installs and runs as a Windows service. The operating system automatically starts and 
restarts the OPC Server. As a service, it runs continuously and unattended (in the background) and 
therefore requires the OPC Remote User Interface (OPCRUI) application to provide user monitoring 
and remote control functions. The OPC Installer installs both applications and their supporting files. 

8.1.1 Installation prerequisites 
The STAR Core must be installed before you install the STAR Gateway Applications. See section 2.4.  

8.1.2 STAR Gateway Installer procedure 
1. From the zip file or other media source, select Setup.exe. 

2. Right click and select Run as Administrator.   

The Installer welcome screen opens 

3. At the installer Welcome screen, click Next to continue. 

Figure 8-1: STAR Gateway Welcome screen 

 
4. Accept the license agreement 

Figure 8-2: License agreement 

 
5. Complete the customer information and click Next. 
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Figure 8-3: Customer Information 

 
6. Select the installation folder. Click Next. 

Figure 8-4: Select folder 

 
7. Start copying files. Click Next. 
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Figure 8-5: Copy files 

 
8. Click Yes to install the Modbus client.  

Figure 8-6: Run Modbus client 

 
9. Select to reboot now. 

Figure 8-7: Reboot now 

 
 

8.2 Configuration 
Before a remote device can communicate with the OPC Server, the device must have an entry in its 
subscriber list to transmit data to the address of the OPC Server. The PGC5000 will send data as an 
OPC type in regard to their subscriber list services. All Multiwave analyzers are configured to report to 
the OPC Server as HIU device types. Legacy analyzers are configured to report to the OPC Server as 



74 | STAR DMS OI | 892J007MNAE 

HIU device types and/or SD device types. The installer appropriately registers your OPC service (ABB 
VistaNET Process Analyzer OPC Server) with Windows. 

8.3 Operation 
The OPC Server operates unattended and performs the following functions: 

8.3.1 Subscriber list builder 
OPC maintains a subscriber list. The subscriber list is used to poll devices (PGC5000 is not polled).  
When a device responds to the poll request, status information is returned. If the device does not 
respond, that information is collected as well. The subscriber list can be manipulated by the OPCRUI 
application. In addition, each device should have the OPC Service configured into its subscriber list as 
an HIU device type (HIU/SD for Multiwave, OPC for PGC5000). 

As each device reports, OPC checks to see if that device already has an entry in its subscriber list. If 
no entry exists, OPC checks for address and naming information for this device, then adds all 
significant information to the subscriber list.  This effectively self-subscribes any device that is 
reporting to OPC. The subscriber list is persisted for future invocations. 

8.3.2 Polling 
For Multiwave analyzers and legacy analyzers, OPC cycles through each device in the subscriber list at 
the configured poll interval (default is five seconds). If the device is configured with redundant 
addresses in OPC’s subscriber list, OPC alternates poll requests between address1 and address2.  
Based on poll requests and poll responses, OPC updates IsConnected1 and IsConnected2 tags 
accordingly for each device. 

Analytical devices respond to poll requests with an online/offline status for each detector. The tags 
associated with this device (e.g. MW*.Online) are updated from the poll response message. If there is 
no poll response on either configured channel for a Multiwave, all MW*.Online tags for that particular 
controller are set to “FALSE”. 

The PGC5000 does not respond to poll requests from the OPC Server. The OPC Server updates the 
IsConnected tags based on status updates from the PGC5000. 

8.4 Tag names 
Tag names used by the OPC represent data from various connected devices. There are four types of 
instrument controllers configured to operate with the OPC: PGC2000/3100, PGC5000, RVP, and MW. 
For any given controller, there may be multiple analysis streams and/or components. The following 
tag lists define the names used and the types of data available for each device. 

Placeholders within tag name definitions allow for the compact expression of similar tag names that 
could occur multiple times within the namespace of the OPC Server. 

 The “<” character signifies the beginning of a placeholder. 
 The “>” character signifies the ending of a placeholder. 
 Text within the placeholder in bold signifies text common to all instances of a similar tag name. 
 Text within the placeholder in italics signifies a number that may vary in instances of tag names. 
 Text within the placeholder in normal format is a description of the text that will occur in the tag. 
 The “.” and “/” characters are not used in names communicated to the OPC Server. 

8.5 Access rights 
Access rights may either be in Read Only (RO) or Read Write (RW). 

8.6 Origin of tag data 
 AR: Tag is updated by analyzer-reported Analysis Report message (PGC5000 analyzers only) 
 ASU: Tag is updated by RVP-reported ASU Results message (RVP only) 
 Client: Tag is updated by a connected OPC Client 
 CR: Tag is updated by analyzer-reported Calibration Report message (PGC5000 analyzers only) 
 Events: Tag is updated by RVP-reported RVP Events message (RVP only) 
 HIU : Tag is updated by analyzer-reported HIU message (Multiwave only) 
 ISL: Tag is updated by analyzer-reported Instrument Status message (PGC5000 analyzers only) 
 OPC: Tag is updated by the OPC Server based on a timer or internal event 
 PR: Tag is updated by analyzer poll response to the OPC Server Status Poll Request 
 RVP: Tag is updated by RVP-reported RVP Results message (RVP only) 
 SC: Tag is updated by analyzer-reported Status Change message (Multiwave only) 
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 SHS: Tag is updated by analyzer-reported Sample Handling System message (PGC5000 analyzers 
only) 

 SS: Tag is updated by analyzer-reported Stream Status message (PGC5000 analyzers only) 
 VR: Tag is updated by analyzer-reported Validation Report message (PGC5000 analyzers only) 
 

8.7 Server level tags 
Table 8-1: Server level tags 

Server Level OPC 
Tag Name 

Access 
Rights 

Native 
Data Type 

Valid Data Origin 

SetAnalyzerClock RW Date Time DD/MM/YYYY 
HH:MM:SS 

Client 

Watchdog RW Boolean True/False Reset Client,  
Set within 2 seconds 
by OPC 

TraceFlags RW Integer Variable–must be in decimal Client 
 

Table 8-2: TraceFlag values 

Trace Flag Hex Value Decimal Definition 
DEBUG_TCP_SERVER 0x00000001 1 Incoming and outgoing byte streams 
DEBUG_TCP_CLIENT 0x00000002 2 TCP Connection Timeout 
DEBUG_PGC5000_REPORT 0x00000004 4 Breakdown of Reports (Analysis, 

Calibration, and Maintenance)  
Not implemented 

DEBUG_PGC5000_ANALYZER_STATUS 0x00000008 8 Breakdown of Instrument status 
message 

DEBUG_PGC5000_STREAM_STATUS 0x00000010 16 Breakdown of Stream status message 
DEBUG_PGC5000_SHS_STATUS 0x00000020 32 Breakdown of Sample Handling 

System status message 
DEBUG_CLIENT_CALLS 0x00000040 64 All client calls thru the WtOPCSvr.dll 
DEBUG_HIU_SERVER 0x00000080 128 Not Implemented yet 
DEBUG_HIU_CLIENT 0x00000100 256 MW and CAC IsConnected issues 
DEBUG_PGC2000 0x00000200 512 Not Implemented 
DEBUG_MW 0x00000400 1,024 Not Implemented 
DEBUG_CAC 0x00000800 2,048 Not Implemented 
DEBUG_OPC_SERVER 0x00001000 4,096 Not Implemented 
DEBUG_SHELL_TAG 0x00002000 8,192 Not Implemented 
DEBUG_SD_SERVER 0x00004000 16,384 PGC2000 SD Message notification 
DEBUG_MISC 0x00008000 32,768 Miscellaneous debug information 

writes once every 10 minutes. 
Includes: 
 Connection Count 
 Active Tag Count 
 Subscriber Tag Count 
 Device Count 
 PageFaultCount 
 PeakWorkingSetSize 
 WorkingSetSize 
 QuotaPeakPagedPoolUsage 
 QuotaPagedPoolUsage 
 QuotaPeakNonPagedPoolUsage 
 QuotaNonPagedPoolUsage 
 PagefileUsage 
 PeakPagefileUsage 

DEBUG_SHUTDOWN 0x00010000 65,536 Not Implemented 
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8.8 PGC5000 tags 
Naming Conventions for PGC5000 Tags: 

 d - A value between 1 and 12 representing the detector number. 
 t - A value between 1 and 2 representing the DTC number. 
 m - A value between 1 and 5 representing the DTC Zone number 
 e - A value between 1 and 10 representing the EPC Zone number. 
 n - A value between 1 and 4 representing the Sample Handling System (SHS) number. 
 i - A value between 1 and 12 representing the SHS Digital Valve Module (DVM) number. 
 j - A value between 1 and 1 representing the SHS Atmospheric Reference Vent DMT (ARV) 

number.  
 k - A value between 1 and 12 representing the SHS Fast Loop DMT (FLP) number. 
 x - A value between 1 and 12 representing the SHS Flow System (FlowSys) number.  
 

Names listed in OPC tags are exact text matches to names in the PGC5000. If you change names in 
the PGC5000, the system will create new OPC tags to match the new PGC5000 names. The original 
OPC tags will not be forwarded to the new tags. 

Table 8-3: PGC5000 OPC tags 

PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

     
<Name>.ActionRequest RW String  Client 
<Name>.Name RO String  IS SS SHS 

AR CR VR 
<Name>.IsConnected1 (See Note 1) RO Boolean True/False OPC 
<Name>.IsConnected2 (See Note 1) RO Boolean True/False OPC 
<Name>.MasterScopeRollup RO Long 0 = Normal - green 

1 = Indicate - blue 
2 = Warning - yellow 
3 = Alarm - red 
4 = Unknown - none 

AS 

<Name>.RunScript RW String Valid Script Name Client 
<Name>.WatchDogIn RW Boolean True/False OPC  
<Name>.WatchDogOut RW Boolean True/False OPC  
<Name>.ALARMS.Comm Failure Oven1 RO Boolean True/False IS 
<Name>.ALARMS.Comm Failure Oven2 RO Boolean True/False IS 
<Name>.ALARMS.Comm Failure Oven3 RO Boolean True/False IS 
<Name>.ALARMS.Comm Failure Oven4 RO Boolean True/False IS 
<Name>.ALARMS.Compile Error RO Boolean True/False AR CR VR 

IS 
<Name>.ALARMS.Missing Report RO Boolean True/False AR CR VR 
<Name>.ALARMS.Network Comm Failure RO Boolean True/False IS 
<Name>.ALARMS.POST Failure RO Boolean True/False IS 
<Name>.ALARMS.Power Fail RO Boolean True/False IS 
<Name>.ALARMS.Purge Fail MC RO Boolean True/False IS 
<Name>.ALARMS.Runtime Error RO Boolean True/False AR CR VR 
<Name>.ALARMS.Runtime Exceeded RO Boolean True/False AR CR VR 
<Name>.ALARMS.Script Not Found RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #1 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #2 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #3 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #4 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #5 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #6 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #7 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #8 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #9 RO Boolean True/False AR CR VR 
<Name>.ALARMS.User Error #10 RO Boolean True/False AR CR VR 
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PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<Name>.<Oven Name>.ALARMS.CAN 
Comm Failure 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.DET 
Failure 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.DTC 
Failure 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.EPC 
Failure 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.Extended 
I/O Fault 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.Purge Fail 
Oven 

RO Boolean True/False IS 

<Name>.<Oven Name>.ALARMS.Software 
Error 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.Hardware 
Error 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.Software 
Error 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.<Channel 
Name>.Autoignite Limit 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.<Channel 
Name>.Autozero Conflict 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.<Channel 
Name>.DETECTOR Fault 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DETd>.<Channel 
Name>.Flame Out 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 1 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 2 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 3 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 4 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 5 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 6 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 7 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 8 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 9 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 10 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 11 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 12 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 13 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 14 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 15 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.DTC 
Digital Input 16 

RO Boolean True/False IS 



78 | STAR DMS OI | 892J007MNAE 

PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<Name>.<Oven Name>.<DTCt>.Online RO Boolean True/False IS 
<Name>.<Oven 
Name>.<DTCt>.ALARMS.DTC Zone 1 

RO Boolean True/False IS 

<Name>.<Oven 
Name>.<DTCt>.ALARMS.DTC Zone 2 

RO Boolean True/False IS 

<Name>.<Oven 
Name>.<DTCt>.ALARMS.DTC Zone 3 

RO Boolean True/False IS 

<Name>.<Oven 
Name>.<DTCt>.ALARMS.HardwareError 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.ALARMS. 
SoftwareError 

RO Boolean True/False IS 

<Name>.<Oven 
Name>.<DTCt>.ALARMS.T-RatingConflict 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.Setpoint 

RO Float  IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.Temperature 

RO Float  IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.ALARMS. High Temperature 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.ALARMS. Low Temperature 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.ALARMS. Out of Control 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.ALARMS. Ramp Out of Control 

RO Boolean True/False IS 

<Name>.<Oven Name>.<DTCt>.<ZONE 
m>.ALARMS. Temp Sensor Fault 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.Online RO Boolean True/False IS 
<Name>.<Oven 
Name>.EPC.ALARMS.HardwareError 

RO Boolean True/False IS 

<Name>.<Oven 
Name>.EPC.ALARMS.SoftwareError 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 1 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 2 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 3 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 4 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 5 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 6 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 7 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 8 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 9 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC.ALARMS.EPC 
Zone 10 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.Current Pressure 

RO Float  IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.Setpoint 

RO Float  IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.ALARMS.High Pressure 

RO Boolean True/False IS 
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PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<Name>.<Oven Name>.EPC..<Zone 
e>.ALARMS.Low Pressure 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.ALARMS.Out of Control 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.ALARMS.Prsr Sensor Fault 

RO Boolean True/False IS 

<Name>.<Oven Name>.EPC..<Zone 
e>.ALARMS. Ramp Out of Control 

RO Boolean True/False IS 

<Name>.<SHSn>.ALARMS.Node Loss RO Boolean True/False SHS 
<Name>.<SHSn>.ALARMS.Node Addition RO Boolean True/False SHS 
<Name>.<SHSn>.ALARMS.Address Conflict RO Boolean True/False SHS 
<Name>.<SHSn>.<DVMi>.ALARMS.Invalid 
State 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Vol Flow Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Vol Flow Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Vol Flow High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Vol Flow High High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Pressure Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Pressure Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Pressure High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Pressure High High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Temp Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Temp Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Temp High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<ARVj>.A
LARMS.Temp High High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Vol Flow Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Vol Flow Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Vol Flow High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Vol Flow High High 

    

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Pressure Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Pressure Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Pressure High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Pressure High High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Temp Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Temp Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A RO Boolean True/False SHS 
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PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

LARMS.Temp High 
<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Temp High High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Loop DP Low Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Loop DP Low 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Loop DP High 

RO Boolean True/False SHS 

<Name>.<SHSn>.<FLOWSYSx>.<FLPk>.A
LARMS.Loop DP High High 

RO Boolean True/False SHS 

<Name>.<Schedule Name>.Idle (See Note 
2) 

RO Boolean True/False IS 

<Name>.<Schedule Name>.Calibrating RO Boolean True/False IS 
<Name>.<Schedule Name>.Maintenance RO Boolean True/False IS 
<Name>.<Schedule 
Name>.MaintenanceRequest (See Note 3) 

RW Boolean 1 = Maintenance 
2 = Normal 

Client 

<Name>.<Schedule Name>.Offline RO Boolean True/False IS 
<Name>.<Schedule Name>.StopRequest 
(See Note 4) 

RW Boolean True = Idle 
False = Rim 

Client 

<Name>.<Schedule Name>.Validating RO Boolean True/False IS 
<Name>.<Schedule Name>.<Stream 
Name>.AnalysisValid 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.CycleTime 

RO Short Integer 0 – 32767 AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.LastAnalysisName 

RO String Valid Analysis Name AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.LastReportType 

RO Integer 0 – Unknown 
1 – Standard 
2 – Calibration 
3 – Cali Norm 
4 – Validation 
5 – Alarm 
6 – Standard Alarm 
7 – Calibration Alarm 
8 – Cal Norm Alarm 
9 – Validation Alarm 

AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.NewDataReady (See Note 5) 

RW Boolean True/False Client 
AR CR VR 
A 

<Name>.<Schedule Name>.<Stream 
Name>.Online 

RO Boolean True/False SS 

<Name>.<Schedule Name>.<Stream 
Name>.REQUEST AnalysisName (see Note 
7) 

RW Boolean True/False 
Value reset once 
requested Analysis 
name reports. 

Client 

<Name>.<Schedule Name>.<Stream 
Name>.SampleTime 

RO Date Time  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.SoftwareVersion 

RO String ‘xxx.xxx.xxx.xxx’ AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.StreamValid 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS.Offline 

RO Boolean True/False SS AR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Missing Component 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Unknown Component 

RO Boolean True/False AR CR VR 



  

892J007MNAE | STAR DMS OI | 81 

PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Sample Flow Lost (See 
Note 6) 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Dig In Check TCF 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Prsr Check TCF 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Temp Check TCF 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Invalid Analysis 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.ALARMS. Analysis Aborted 

    

<Name>.<Schedule Name>.<Stream 
Name>.CHROMATOGRAMS.NewChromatRe
ady (See Note 5)  

RW Boolean True/False Client  
AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.CHROMATOGRAMS.<DETECTOR 
Name.> 

RO String  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<Component Name>.AmplitudeEOB 

RO Integer  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.AmplitudeEOI 

RO Integer  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.AmplitudeSOB 

RO Integer  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.AmplitudeSOI 

RO Integer  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.BaselineEnd 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.BaselineStart 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.Benchmark 
Deviation 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.Concentration 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.CrestAmplitud
e 

RO Integer  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ExpectedConc
entration 

RO Float  CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ExpectedRT 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.IntegrationEnd 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.IsValid 

RO Boolean True/False AR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.Name 

RO String  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.NegativeArea 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.OldResponseF
actor 

RO Float  CR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.PeakFound 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream RO Float  AR CR VR 
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PGC5000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

Name>.<ComponentName>.PositiveArea 
<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.RespnseFactor 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.RetentionTime 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.RFUpdated 

RO Boolean True/False CR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.TotalArea 

RO Float  AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.UnitsOfMeasur
e 

RO String Percent 
PPM 
PPB 
None 

AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.High 
Concentration 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.High-
High Conc 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.Low 
Concentration 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.Low-
Low Conc 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.Reten
tion Time High 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.Reten
tion Time Low 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.RF 
High Limit 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.RF 
Low Limit 

RO Boolean True/False AR CR VR 

<Name>.<Schedule Name>.<Stream 
Name>.<ComponentName>.ALARMS.Valid
ation 

RO Boolean True/False AR CR VR 

Note 1 – The IsConnected1 and IsConnected2 tags are determined by the channel that is on and the 
configure IP Address in the STAR DMS. 

Note 2 – Cannot be set via OPC Client. This is controlled by the StopRequest tag. Instrument Status 
resets the Idle tag when the schedule is finished. 

Note 3 – Reflects last sent request; does not track Maintenance item. 

Note 4 – Reflects last sent request; does not track Idle item. 

Note 5 – Set by OPC. Reset by Client, by OPC with configured timer. 

Note 6 – Currently not working. 

Note 7 – The OPC Server can request multiple Ad-hoc analyses. The REQUEST_AnalysisName OPC tag 
must be set to a 1, then transitioned back to a 0 before requesting a second Ad-hoc request. 

8.9 MW tags 
Naming Conventions for MW2000 Tags: 

 n a value between 1 and 255 representing a unique device number for a MW2000 on a STAR 
device network. Numbers over 99 represent simulated analyzers. 

 c a value between 1 and 8 representing a unique component number. 
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Table 8-4: MW tags 
MW2000 OPC Tag Name Access 

Rights 
Native 
Data 
Type 

Valid Data Origin 

<MWn>.ActionRequest RW String Benchmark Zero 
Benchmark Span 
Benchmark Both 
Calibrate Zero 
Calibrate Span 
Calibrate Both 
Clear Warnings 
Clear Alarms 
Go Offline 
Go Online 

Client 

<MWn>.AnalyzerType RO String MW2000 OPC 
<MWn>.CycleTime (in seconds) RO Short 

Integer 
0 - 65525 HIU 

<MWn>.InBench RO Boolean True/False PR SC HIU 
<MWn>.InCal RO Boolean True/False PR SC HIU 
<MWn>.IsConnected1 RO Boolean True/False PR 
<MWn>.IsConnected2 RO Boolean True/False PR 
<MWn>.IsValid RO Boolean True/False HIU 
<MWn>.Name RO String  HIU 
<MWn>.NewDataReady  
(See Note 1) 

RW Boolean True/False HIU 
May be reset 
OC or by 
OPC with 
configured 
timer 

<MWn>.Online RO Boolean True/False PR 
<MWn>.SampleTime RO Date/ 

Time 
MM/DD/YYY 
HH:MM:SS AM/PM 

HIU 

<MWn>.TotalUnknown (See Note 2) RO Float  HIU 
<MWn>.ValidationCode RO Unsigned 

Short 
Integer 

0 – Valid 
1 – Warning 
2 - Invalid 

HIU 

<MWn>.CONTROL.Register1  
(see Note 3) 

RW Unsigned 
Short 
Integer 

 Client 

<MWn>.CONTROL.Register2  
(see Note 3) 

RW Unsigned 
Short 
Integer 

 Client 

<MWn>.CONTROL.Register3  
(see Note 3) 

RW Unsigned 
Short 
Integer 

1 – Benchmark Zero 
2 – Benchmark Span 
3 – Benchmark Both 
4 – Calibrate Zero 
5 – Calibrate Span 
6 – Calibrate Both 
7 – Clear Warnings 
8 – Clear Alarms 
9 – Go Offline 
10 – Go Online 

Client 

<MWn>.CONTROL.Command RW Boolean True/False Client 
<MWn>.ALARMS.CastingTemperatur
e 

RO Boolean True/False HIU 

<MWn>.ALARMS.CellPressure RO Boolean True/False HIU 
<MWn>.ALARMS.CellTemperature RO Boolean True/False HIU 
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MW2000 OPC Tag Name Access 
Rights 

Native 
Data 
Type 

Valid Data Origin 

<MWn>.ALARMS.CheckSum RO Boolean True/False HIU 
<MWn>.ALARMS.ChopperSignal RO Boolean True/False HIU 
<MWn>.ALARMS.CmptBenchmark RO Boolean True/False HIU 
<MWn>.ALARMS.CmptCalibration RO Boolean True/False HIU 
<MWn>.ALARMS.CmptConcentration RO Boolean True/False HIU 
<MWn>.ALARMS.CommFailure RO Boolean True/False HIU 
<MWn>.ALARMS.DetectorACVoltage RO Boolean True/False HIU 
<MWn>.ALARMS.DetectorDCVoltage RO Boolean True/False HIU 
<MWn>.ALARMS.DetectorVoltage RO Boolean True/False HIU 
<MWn>.ALARMS.ExtInput#1 
Voltage 

RO Boolean True/False HIU 

<MWn>.ALARMS.ExtInpurt#2 
Voltage 

RO Boolean True/False HIU 

<MWn>.ALARMS.Initialization RO Boolean True/False HIU 
<MWn>.ALARMS.MicroProcessor RO Boolean True/False HIU 
<MWn>.ALARMS.Overrange RO Boolean True/False HIU 
<MWn>.ALARMS.PowerSupply RO Boolean True/False HIU 
<MWn>.ALARMS.PowerFail RO Boolean True/False HIU 
<MWn>.ALARMS.TempControl RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#1 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#2 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#3 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#4 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#5 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#6 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#7 RO Boolean True/False HIU 
<MWn>.ALARMS.UserSensor#8 RO Boolean True/False HIU 
<MWn>.<CMPTc>.Concentration RO Float  HIU 
<MWn>.<CMPTc>.Name RO String  HIU 
<MWn>.<CMPTc>.SlopeFactor RO Float  HIU 
<MWn>.<CMPTc>.ZeroOffset RO Float  HIU 
<MWn>.<CMPTc>.BenchmarkSpan RW Float  HIU 
<MWn>.<CMPTc>.BenchmarkZero RO Float  HIU 
Note 1 – May be reset by the client or by OPC with configured timer. 

Note 2 – The OPC Server creates this tag and sets it to 0. There is no information coming from the 
MW for unknown components, but older Host Links need this tag to be present. 

Note 3 – To issue a command to an analytical device, the DCS must first fill the defined register set 
with the appropriate values (which represent the desired action) and then initiate the request by 
setting the command coil. The setting of the command coil interprets the contents of the command 
registers and transmits the request to the appropriate analytical device.  To initiate a new command, 
the DCS must first clear the command coil by writing a zero. The transition of the command coil status 
from zero to one initiates the action. 

8.10 RVP tags 
Naming Conventions for RVP Tags 

 n A value between 1 and 255 representing the 4th octet of the IPv4 address 
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Table 8-5: RVP tags 
RVP OPC Tag Name Access 

Rights 
Native 
Data Type 

Valid Data Origin 

RVPn.Alarm Code RO Signed 
Char 

0 = No Alarm 
1 = Temperature – out of analysis 
range 
2 = Temperature – out of instrument 
range 
3 = Temperature – heater runaway 
4 = Level sensor – zero limits 
exceeded 
5 = Transducer – zero limits exceeded 
6 = Overpressure – cycle Aborted 
7 = Air purge pressure – out of 
specification 
8 = Leaking cell – cell Pressure 
changing 
9 = Level sensor – cell not filled 
10 = Level sensor – cell filled too fast 
11 = AirSat temperature – out of 
instrument range 
12 = AirSat temperature – out of 
analysis range (high) 
13 = AirSat temperature – out of 
analysis range (low) 
14 = AirSat limit sensor: push failed 
15 = AirSat limit sensor: pull failed” 
16 = AirSat sample fill failed 
17 = AirSat level sensor dry 

RVP Events 

<RVPn>.AnalyzerType RO String RVP Client 
<RVPn>.ASU 
Temperature 

RO Float  ASU Results 

<RVPn>.Fill Time RO Float  RVP Results 
<RVPn>.Level RO Short 

Integer 
0 – 65525 RVP Results 

<RVPn>.Name RO String RVPn where n = 4th octet of IPv4 
address 

Client 

<RVPn>.Purge Pressure RO Float  RVP Results 
<RVPn>.RVP RO Float  RVP Results 
<RVPn>.RVP 
Temperature 

RO Float  RVP Results 

<RVPn>.Zero Pressure RO Float  RVP Results 
 

8.11 PGC2000/3100 tags  
Naming Conventions for PGC2000 Tags: 

 n A value between 1 and 255 
 d A value between 1 and 2 
 s A value between 1 and 32 
 c A value between 1 and 32 
Table 8-6: PGC2000/3100 tags 

PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<GCCn>.ActionRequest RW String Calibrate Method # 
Benchmark Method # 
Start Analysis 
Start Detector # 
Stop Analysis 
Stop Detector # 
Activate Stream # 
Deactivate Stream # 
Analyze Stream # 

Client 
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PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

Assign Method # to 
Stream # 
Clear Alarms 
Stop Analysis Now 
Stop Detector Now # 
Save Tables to E2 
Change RealTime Basic 
State 

<GCCn>.AnalyzerType (Hardcoded) RO String PGC2000 OPC 
<GCCn>.IsConnected1 (See Note 1) RO Boolean True/False PR 
<GCCn>.IsConnected2 (See Note 1) RO Boolean True/False PR 
<GCCn>.Name RO String  

(10 bytes) 
Valid PGC2000 Name HIU 

<GCCn>.RefreshTime RO Unsigned 
Short 
Integer 

0 - 65535 HIU 

<GCCn>.CONTROL.Command RW Boolean True/False Client 
<GCCn>.CONTROL.Register1 (see Note 3) RW Unsigned 

Short 
Integer 

Command Detector Client 

<GCCn>.CONTROL.Register2 (see Note 3) RW Unsigned 
Short 
Integer 

Commanded 
Stream/Method 

Client 

<GCCn>.CONTROL.Register3 (see Note 3) RW Unsigned 
Short 
Integer 

1 – Start Analysis 
2 – Activate Stream 
3 – Request Analysis 
4 – Request 
Calibration 
5 – Request 
Benchmark 
6 – Assign Method to 
Stream 
7 – Stop Analysis 
8 – Bypass Stream 
9 – Clear Alarms 
10 – Stop Analysis 
NOW 
11 – Save Tables to E2 
12 – Change RealTime 
Basic 
         State 

Client 

<GCCn>.ALARMS.AutoZero RO Boolean True/False HIU 
<GCCn>.ALARMS.CarrierGas RO Boolean True/False HIU 
<GCCn>.ALARMS.CommFailure RO Boolean True/False HIU 
<GCCn>.ALARMS.CommonHardware RO Boolean True/False HIU 
<GCCn>.ALARMS.CommonSoftware RO Boolean True/False HIU 
<GCCn>.ALARMS.FlameOut RO Boolean True/False HIU 
<GCCn>.ALARMS.HighConc RO Boolean True/False HIU 
<GCCn>.ALARMS.HighOvenTemp RO Boolean True/False HIU 
<GCCn>.ALARMS.HydrogenPressure RO Boolean True/False HIU 
<GCCn>.ALARMS.Idle RO Boolean True/False HIU 
<GCCn>.ALARMS.LowConc RO Boolean True/False HIU 
<GCCn>.ALARMS.LowOvenTemp RO Boolean True/False HIU 
<GCCn>.ALARMS.LowStandard RO Boolean True/False HIU 
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PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<GCCn>.ALARMS.MissingCmpt RO Boolean True/False HIU 
<GCCn>.ALARMS.PowerFail RO Boolean True/False HIU 
<GCCn>.ALARMS.PressureBoard RO Boolean True/False HIU 
<GCCn>.ALARMS.PressureBoardZone1 RO Boolean True/False HIU 
<GCCn>.ALARMS.PressureBoardZone2 RO Boolean True/False HIU 
<GCCn>.ALARMS.PressureBoardZone3 RO Boolean True/False HIU 
<GCCn>.ALARMS.PressureBoardZone4 RO Boolean True/False HIU 
<GCCn>.ALARMS PressureBoardZone5 RO Boolean True/False HIU 
<GCCn>.ALARMS.PurgeAir RO Boolean True/False HIU 
<GCCn>.ALARMS.ResponseFactor RO Boolean True/False HIU 
<GCCn>.ALARMS.SampleFlow RO Boolean True/False HIU 
<GCCn>.ALARMS.TCF RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoard RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoardZone1 RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoardZone2 RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoardZone3 RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoardZone4 RO Boolean True/False HIU 
<GCCn>.ALARMS.TemperatureBoardZone5 RO Boolean True/False HIU 
<GCCn>.ALARMS.UnknownCmpt RO Boolean True/False HIU 
<GCCn>.ALARMS.UserSensor#1 RO Boolean True/False HIU 
<GCCn>.ALARMS.UserSensor#2 RO Boolean True/False HIU 
<GCCn>.ALARMS.UserSensor#3 RO Boolean True/False HIU 
<GCCn>.ALARMS.UserSensor#4 RO Boolean True/False HIU 
<GCCn>.ALARMS.UserSensor#5 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#1 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#2 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#3 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#4 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#5 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#6 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#7 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#8 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#9 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#10 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#11 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#12 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#13 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#14 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#15 RO Boolean True/False HIU 
<GCCn>.ALARMS.VistaBasic#16 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetAutoZero RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetCarrierGas RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetCommFailure RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetCommonHard
ware 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetCommonSoftw
are 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetFlameOut RO Boolean True/False HIU 
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PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<GCCn>.<DETECTORd>.DetHighConc RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetHighOvenTem
p 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetHydrogenPress
ure 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetIdle RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetLowConc RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetLowOvenTemp RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetLowStandard RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetMissingCmpt RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetPowerFail RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetPressureBoard RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetPressureBoard
Zone1 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetPressureBoard
Zone2 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetPressureBoard
Zone3 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetPressureBoard
Zone4 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetPressureBoard
Zone5 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetPurgeAir RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.RefreshTime RO Unsigned 

Short 
Integer 

0 - 65535 HIU 

<GCCn>.<DETECTORd>.DetResponseFacto
r 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetSampleFlow RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetTCF RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetTemperatureB
oard 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetTemperatureB
oardZone1 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetTemperatureB
oardZone2 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetTemperatureB
oardZone3 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetTemperatureB
oardZone4 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetTemperatureB
oardZone5 

RO Boolean True/False HIU 

<GCCn>.<DETECTORd>.DetUnknownCmpt RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetUserSensor#1 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetUserSensor#2 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetUserSensor#3 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetUserSensor#4 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetUserSensor#5 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#1 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#2 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#3 RO Boolean True/False HIU 
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PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<GCCn>.<DETECTORd>.DetVistaBasic#4 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#5 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#6 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#7 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#8 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#9 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#10 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#11 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#12 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#13 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#14 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#15 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.DetVistaBasic#16 RO Boolean True/False HIU 
<GCCn>.<DETECTORd>.InBench RO Boolean True/False PR SC 
<GCCn>.<DETECTORd>.InCal RO Boolean True/False PR SC 
<GCCn>.<DETECTORd>.Online RO Boolean True/False PR SC 
<GCCn>.<STRMs>.Active RO Boolean True/False PR SC 

HIU 
<GCCn>.<STRMs>.CycleTime RO Unsigned 

Short 
Integer 

0 - 65535 SD HIU 

<GCCn>.<STRMs>.IsValid RO Boolean True/False HIU 
<GCCn>.<STRMs>.LastReportType RO String  HIU 
<GCCn>.<STRMs>.NewDataReady (See 
Note 2) 

RW Boolean True/False Client 

<GCCn>.<STRMs>.SampleTime RO Date Time  HIU 
<GCCn>.<STRMs>.TotalPeakArea RO Float  HIU 
<GCCn>.<STRMs>.TotalUnknown RO Float  HIU 
<GCCn>.<STRMs>.ValidationCode RO Integer 0 - Valid 

1 – Warning 
2 - Invalid 

HIU 

<GCCn>.<STRMs>.<CMPTc>.Concentratio
n 

RO Float  SD HIU 

<GCCn>.<STRMs>.<CMPTc>.Name (10 
bytes) 

RO String  HIU 

<GCCn>.<STRMs>.<CMPTc>.PeakArea RO Float  SD 
<GCCn>.<STRMs>.<CMPTc>.PeakCrestAm
plitude 

RO Float  SD 

<GCCn>.<STRMs>.<CMPTc>.PeakEndAmp
litude 

RO Float  SD 

<GCCn>.<STRMs>.<CMPTc>.PeakEndTime RO Float  SD 
<GCCn>.<STRMs>.<CMPTc>.PeakHeight RO Float  SD 
<GCCn>.<STRMs>.<CMPTc>.PeakStartAm
plitude 

RO Float  SD 

<GCCn>.<STRMs>.<CMPTc>.PeakStartTi
me 

RO Float  SD 

<GCCn>.<STRMs>.<CMPTc>.ResponseFac
tor 

RO Float  SD 

<GCCn>.<STRMs>.<CMPTc>.RetentionTim
e 

RO Float  SD 
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PGC2000 OPC Tag Name Access 
Rights 

Native 
Data Type 

Valid Data Origin 

<GCCn>.<STRMs>.<CMPTc>.UncorrectedP
eakArea 

RO Float  SD 

Note 1 – The IsConnected1 and IsConnected2 reflect the true connected status of the channel based 
on the configured IP Addresses. By default, the PGC2000 will attempt to send all communications to 
the OPC Server via channel 1. And likewise, the OPC Server will attempt to make all requests via 
channel 1. The IsConnected tags are set by the status of the Poll Response.   

Note 2 – Set by OPC. May be reset by Client or OPC Timer. 

Note 3 – To issue a command to an analytical device, the DCS must first fill the defined register set 
with the appropriate values (which represent the desired action) and then initiate the request by 
setting the command coil. The setting of the command coil interprets the contents of the command 
registers and transmits the request to the appropriate analytical device. To initiate a new command 
the DCS must first clear the command coil by writing a zero. The transition of the command coil status 
from zero to one initiates the action. 

 

9 OPCRUI 
9.1 Introduction 
The OPCRUI application can be launched by clicking on the shortcut in Start->Programs->ABB STAR-
>OPCRUI or by launching it from the STAR Client. 

Upon execution, the OPCRUI will attempt to connect to the OPC Server to load its device, router, and 
user tables. While the OPCRUI is disconnected, the title is as shown in Figure 9-1. 

Figure 9-1: OPC Interface Window 

 

9.2 File 
The File menu is active and has the following commands while there is no current connection. 

 File -> Connect  (Connect to an OPC Server) 
 File -> Refresh Local NIS (Refresh tables) 

9.2.1 Connect 
“File -> Connect” commands the application to connect to an OPC Server. The Remote OPC Service 
Address dialog box appears (see Figure 9-2). Select from the list of registered OPC servers or enter 
the OPC Services IP Address directly and click OK. 
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Figure 9-2: Remote OPC Service Address Window 

 
A good connection will produce a screen with about a 1 second pause to obtain the data. 

Up to 30 of the most recent OPC Service events will display in the main window of the OPCRUI. The “-
>” indicator denotes that the message originated at the OPC Service. When a message appears 
without the indicator, this event originated local to the OPCRUI. For example, if the RUI cannot 
contact the intended OPC Service on a Connect request, an error message will be reported without the 
“->” indicator. All local error events will appear in this main window without the “->” indicator. 

9.2.2 Refresh local NIS 
“File -> Refresh Local NIS” commands the application to query the STAR Network Service for device, 
router, and user tables. 

This is where the devices that show up in later dialog boxes originate. If the devices are not in the 
tables, you will not see those devices as choices when modifying the subscriber list. Use the refresh 
command if the tables have been updated. 

9.3 Server 
When you click on Server in the OPCRUI window, the Server drop-down menu appears, with the 
following selections: 

 Server -> NewDataReady 
 Server -> Poll Interval 
 Server -> Refresh NIS 
 Server -> Load Configuration 
 Server -> Subscriber List 
 Server -> Restore Tags 

9.3.1 New data ready 
When you select NewDataReady from the Server menu, the Analyzer New Data Ready window 
appears (Figure 9-3). 

Figure 9-3: Analyzer New Data Ready Window 

 
If the New Data Ready Reset By Client option is checked, the OPC Server does not reset the 
NewDataReady tag. The OPC client would be responsible for writing a reset value of “0” to the 
NewDataReady tag when it has completed processing the other tags. If the New Data Ready Reset By 
Client option is not checked, then the OPC Server will reset the NewDataReady tag after the Hold Time 
has expired. 

9.3.2 Poll interval 
When you select Poll Interval from the Server menu, the Polling Interval window appears (Figure 
9-4). 
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Figure 9-4: Polling Interval Window 

 
From the dialog box, you can set the rate at which the OPC Server polls legacy devices to obtain their 
current status. This information is used to update the tags associated with IsConnected1, OnLine, and 
InCal. The PGC5000 is not polled because PGC5000 updates from a status update sent from the 
instrument to the OPC server. 

9.3.3 Refresh NIS 
When you select Refresh NIS from the Server menu, this refreshes three tables: Device Definition 
Table, User Password Table, and Router Table. 

This is where the devices that show up in later dialog boxes originate. If the devices are not in the 
tables, you will not see those devices as choices when modifying the subscriber list. For example, only 
the OPC Servers that are listed in the Device Definition Table will appear in the Connect Dialog box. 
Use the refresh command if the tables have been updated. 

9.3.4 Load configuration 
When you select Load Configuration from the Server menu, the latest Subscriber List from the OPC 
Server appears. This is needed now because the OPC Service will automatically add subscribers to its 
list if a new device reports to it. Prior to editing the Subscriber List, select Load Configuration to 
ensure you have the current list of subscribers (see the next paragraph). 

9.3.5 Subscriber list 
When you select Subscriber List from the Server menu, the following list appears (Figure 9-5). 

Figure 9-5: Subscriber List Screen 

 

 

IMPORTANT NOTE: The PGC5000 in the subscriber is a version 3 PGC5000 Generation 1 analyzer. 
PGC5000 analyzers that are generation 4 and above are not contained in the subscriber list of the 
OPC Server. 
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Analytical devices (PGC2000/3100 and MW) listed in the OPC Server Subscriber List will be polled 
periodically to obtain status information. Tags representing an analyzer’s online status and stream 
active status will be updated with the results of this polling. If an analyzer is not listed in the OPC 
Server Subscriber List, its status tags will not be refreshed. You may add new devices, modify, and/or 
delete existing entries. After changing the list, you must click Update Table to send the new 
configuration back to the OPC Service. 

 

IMPORTANT NOTE: OPC automatically adds devices to the Subscriber List when a device reports 
to it. You must remove the OPC Server as a subscriber from the device’s Subscriber List before 
manually deleting it from the RUI. Deleting entries from the RUI will work temporarily, but the next 
time the device reports it will be added back into the Subscriber List. 

9.3.6 Restore tags 
When you select Restore Tags from the Server menu, this will refresh the tag lists. 

9.4 View 
From the View menu, you can view Active Tags and Analyzer reports. 

9.4.1 Active tags 
When you select Active Tags from the View menu, the following window appears (Figure 9-6). 

Figure 9-6: Active OPC Tags Window 

 

 

IMPORTANT NOTE: PGC5000 tags are not displayed and PGC5000 reports cannot be displayed. 

This window displays a list of all active OPC tags currently subscribed to by attached client 
applications. The OPC Server only maintains tag values for devices that are active. The list is 
displayed in a window containing the associated tag name, timestamp, value, and quality flag for each 
active OPC tag. 

9.4.2 Analyzer 

When you select Analyzer from the View menu, the following window appears (Figure 9-7). 

Figure 9-7: Show Most Recent Report Window 
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After you enter the desired analyzer number (MW and PGC2000 only), a dialog box appears 
containing the sample inject time, alarms, and associated component concentration values for the last 
report (see Figure 9-8). This report is static: the values will not automatically be refreshed if a new 
report is received while this command is active. The OPC Server maintains only one report per 
analyzer. The report shows the most recent analysis report for the selected analyzer. 

Figure 9-8: Typical Analyzer Report Screen 

 
 

10 Modbus 
10.1 Modbus description 
The Modbus interface consists of Modbus software installed in the STAR Gateway and the PGC5000. 
Modbus software translates data from the ABB analyzer system into the Modbus RTU or Modbus TCP 
format recognizable by standard DCS gateway devices. To use the serial connection with the 
PGC5000, connect through a Moxa MGATE MB3170 protocol converter. 

The PGC5000, as part of its base design, supports a Modbus TCP interface (acting as a slave). 
Knowing that this interface is used to communicate with control systems, the servicing of this task is 
of high priority; therefore, care must be given when configuring the Modbus master interface to the 
PGC5000. Unreasonable and illogical configuration of the Modbus master can result in resource issues 
with the PGC5000 which can lead to unpredictable behavior. With version 3.0.3.14 of the PGC5000 
software, the fastest response time of the Modbus will be set to 50 ms. 

The following general guidelines are recommended when configuring the interface: 

 When both networks are connected to one control system, use the secondary network only for 
failover. The Analyzer Network design is for all normal network traffic to be on the Primary 
network and to use the Secondary network only upon failure (inability to communicate) of the 
Primary network. 

 Use the NewDataReady tags that indicate when report data has changed and read them, rather 
than polling for all report data continually. In a typical analyzer, data may not change for 6 to 10 
minutes (cycle time of analysis). Polling for report data at a sub-second interval places an undue 
load on both the PGC5000 and the control system. Polling rates from Master connections should 
be one second or greater. 

 Group transactions as much as possible, using function codes 1, 2, 3, 4 to perform reads of blocks 
of data. This is a more efficient use of each packet of data: a read of 2 registers 10 times (10 
transactions, 40 bytes) is much more costly of CPU time, for both the control system and 
PGC5000, than a read of 20 registers once (1 transaction, still 40 bytes). 

 Do not configure the Modbus master to poll for large blocks of empty data, as this is not an 
efficient use of transactions. 

10.2 Protocol 
It is beyond the scope of this manual to describe the Modbus protocol. Consult your DCS 
documentation for explanation of concepts and terminology that may be unfamiliar to you. 

The Modbus protocol provides a set of rules which allows data to be passed between any two 
compatible devices. The protocol defines how the data is to be transferred, but it does not define what 
the contents of the data are. In order for the analyzer/DCS interface to operate, both the STAR 
Gateway (with Modbus software) and the DCS must be configured to define the functions to be 
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implemented and the corresponding data addresses to be used. The Modbus interface can provide 
analytical composition data from the analyzer system to the DCS as well as various status 
information, (such as data validity, analyzer availability, and new data availability). The Modbus 
interface can also accept limited analyzer control functions from the DCS (e.g. request for calibration, 
stream activation, etc.). 

The STAR Gateway behaves as a slave device in a Modbus system using the Modbus RTU protocol. 
However, not all Modbus functions are supported. The functions supported by the STAR Gateway are: 

 01 Read coil status 
 02 Read discrete input status 
 03 Read holding registers 
 04 Read input registers 
 05 Force single coil 
 06 Preset single register 
 08 Loopback diagnostic test (limited) 
 15 Force multiple coils 
 16 Preset multiple registers 
The STAR Gateway supports all standard Modbus data types: input and holding registers, discrete 
inputs, and coils. In addition, the STAR Gateway supports the IEEE floating point format that requires 
two registers. The DCS cannot write to the input registers and discrete inputs; only the STAR Gateway 
can write to these registers and inputs. 

The STAR Gateway requires a DB9 connector at its end of the STAR Gateway/DCS communications 
cable for the RTU serial. The pins used and their functions are: 

 2 - Receive Data 
 3 - Transmit Data 
 5 - Signal Ground 

10.3 Client configurator 
The STAR Gateway uses Client Configurator software to map analyzer points to Modbus coils and 
registers. The Configuration Client's main display is the Client Configurator. To display the Client 
Configurator, click Classic Applications in the tool bar, select Client Configurator and then 
Launch. The Client Configurator screen will appear (see Figure 10-1). From this screen and its 
subordinates, you can perform all the necessary Modbus configuration. 

Figure 10-1: Client Configurator 

 
Near the top of the Client Configurator is the Toolbar (Figure 10-2). 
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Figure 10-2: Toolbar 

 

Icon Action Description 
A Start a new Configuration Opens the selected configuration file 
B Addresses configuration Assigns registers for the selected configuration file 
C Read Config  Reads configuration file into Client Configurator 
D Save Configuration Saves the selected configuration file 
E View Configuration Allows you to view the selected configuration file's 

contents 
F Download Configuration Allows you to retrieve the current configuration file from 

the STAR Gateway 
G Add PGC5000 Adds one entry in the PGC5000 Configuration 
H Add PGC2000/3100 Adds one entry in the PGC2000/3100 Configuration 
I Add MW Adds one entry in the MW Configuration 
J Add CAC2000 Adds one entry in the CAC2000 Configuration 
K Add Advance Optima Adds one entry in the AO Configuration 
L Add FTIR Adds one entry in the FTIR Configuration 
M Add RVP Adds one entry in the RVP Configuration 
N Enter Sales Order Information Allows you to insert and review sales order information 
O Configure Communication 

Parameters 
Allows you to verify or set the various communications 
parameters 

P Help on Configurator Provides context-sensitive help for Configuration Client 
features 

Q About Client Configurator  Displays the Configuration Client's version information and 
allows you to view System Info 

 

10.4 Configuration client auto mapping (Modbus) 
Mapping in the PGC5000 is tied to the actual text names in the PGC5000, so the text in the mapping 
must exactly match the names in the PGC5000. To enter the names manually can be tedious so there 
is a feature to request the configuration from the PGC5000 automatically and to generate the map 
from the configuration. 

To take advantage of this feature in the Configuration Client, perform the following steps: 

1. Click the Add PGC5000 icon (see Figure 10-3). 
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Figure 10-3: Add Client Configurator Dialog Box 

 
2. Click Yes when asked if you want to upload XML files from the analyzer (see Figure 10-4). 

Figure 10-4: Upload Files Dialog Box 

 
3. When requested, enter the IP address of the PGC5000. In the example in Figure 10-5, the 

address is 10.1.0.75. 
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Figure 10-5: Enter IP Address Dialog Box 

 
4. Click OK. After a short pause, the mapping should appear for the PGC5000 in the Treeview on 

the left (see Figure 10-6). 

Figure 10-6: Mapping Shown in Treeview 
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IMPORTANT NOTE: If the analyzer does not appear in the list, you have the option to browse to a 
folder that contains the configuration. 

10.5 Global configuration 
With the ABB Client Configurator running, you can access the various global configuration items, 
which consist of Protocol, Packing, Sales Order Information, and Warn on Duplicate Addresses. 

10.5.1 Communications 
Click on the Configure Communication Parameters icon in the Client Configurator toolbar and the 
following dialog box appears (see Figure 10-7) to verify or set the various communications 
parameters. 

Figure 10-7: Selecting communications parameters 

 
In this dialog box, you can verify or set the following parameters: 

 Baud Rate 
 Serial Port 
 Data Bits 
 Stop Bits 
 Parity 
Verify all communications parameters with those listed in the data package supplied with the 
equipment. If you make any changes to the communications parameters, click OK to save the 
changes, or click Cancel to retain the original settings. 

10.5.2 Protocol 
This menu allows you to select the Modbus protocol. Select MODBUS in the Protocol area at the top 
left of the Client Configurator screen (see Figure 10-1). 

10.5.3 Packing 
Packing addresses the amount of space allocated between devices in the Modbus registers. If you 
expect there might be changes in the size of the configuration files, then a moderate or loose packing 
should be selected. If register space must be optimized, you can select tighter packing. To access 
packing, click on the type of packing desired in the Packing area at the top of the Client Configurator 
screen (see Figure 10-1). 

10.5.4 Sales order information 
This function allows you to insert and review the relevant sales order information. Click the Enter 
Sales Order Information icon in the Client Configurator toolbar and type the required information 
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(see Figure 10-8). The sales order information is listed in the Data Package supplied with the 
equipment.  Click OK to save the changes or click Cancel to retain the original settings. 

Figure 10-8: Sales Order Information 

 

10.5.5 Warn on duplicate addresses 
This function allows the software to warn you if the same Modbus device slave address has been 
assigned to more than one analytical instrument. To activate the function, check Warn on Duplicate 
Addresses at the top of the Client Configurator (see Figure 10-1). GCs and MWs are usually mapped 
to one Modbus slave address. 

10.6 PGC5000 configuration 
To verify or set a PGC5000's configuration, use the Client Configurator (see Figure 10-1). 

To add or edit a PGC5000: 

1. Click on the PGC5000 tab. 

2. Review the list of devices shown in the PGC5000 tab. 

3. In the GCs box to the right of the window, use the up/down control to add and delete GCs (see 
Figure 10-9). 

Figure 10-9: Typical PGC5000 Configuration Dialog Box 

 
4. Enter the appropriate information in the fields that appear, then click OK. 

10.6.1 PGC5000 properties 
1. Select the desired PGC5000 listed in the PGC5000 tab. 
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2. If a Modbus address is required, enter the Address for the PGC5000 using the up/down control. 

3. To configure alarms, click Configure Alarms. 

4. When the Alarm Configuration dialog box appears (see Figure 10-10), check the box for each 
alarm to be configured, select the Register Type (Input Status or Coil Status) and, if necessary, 
enter a Register Number. 

Figure 10-10: Typical Alarm Configuration Dialog Box 

 
5. In the Detectors field of the PGC5000 Configuration dialog box, use the up/down control to 

enter the desired number of detectors (each GC must have at least one detector). 

6. In the Streams field, use the up/down control to enter the desired number of streams. 

10.6.2 Stream configuration 
1. On the PGC5000 tab, double-click on the desired stream number. The Stream Configuration 

dialog box appears. 

2. Enter the desired changes and then click OK to save the changes or click Cancel to retain the 
original settings. 

10.6.3 Component configuration 
1. On the PGC5000 tab, double-click on the desired component. The Component Configuration 

dialog box appears. 

2. Enter the desired changes and then click OK to save the changes or click Cancel to retain the 
original settings. 

10.6.4 Complete PGC5000 configuration 
1. When you have completed all entries, click the Address Configuration icon on the Client 

Configurator toolbar to assign registers. 

2. Click the Save Configuration icon on the toolbar. 

3. When the Save Configuration File window appears, enter the desired file name and click Save. 

10.7 PGC2000 configuration 
To verify or set a PGC2000's configuration, use the Client Configurator (see Figure 10-1).   

To add or edit a PGC2000: 

1. Click the PGC2000 tab. 

2. Review the list of devices shown. 

3. In the PGC2000s area to the right of the window, use the up/down control to add or delete GCs 
(see Figure 10-11). The Current PGC2000 Properties dialog box will be highlighted. 
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Figure 10-11: Typical PGC2000 Configuration Dialog Box 

 
 

10.7.1 PGC2000 properties 
1. Click on the desired GCC listed. 

2. If a Modbus address is required, enter the Modbus Address for this PGC2000 using the up/down 
control. 

3. Enter the network identification number for this PGC2000 in the Remote # field. This is how the 
GC is named. 

4. If desired, enter the plant’s identification for the PGC2000 in the GC Alias field. 

5. To configure alarms, click Configure Alarms. 

6. When the Alarm Configuration dialog window appears (see Figure 10-10), check each alarm to 
be configured, select the Register Type (Input Status or Coil Status) and, if necessary, enter a 
Register Number. 

7. In the Detectors field of the Current PGC2000 Properties area, use the up/down control to enter 
the desired number of detectors (each GC must have at least one detector). 

8. In the Streams field, use the up/down control to enter the desired number of streams. 

10.7.2 Stream properties 
1. In the GC tab, double-click on the desired stream number. 

2. Enter the appropriate information in the fields in the Current Stream Properties area. 

3. Click OK to save the changes or click Cancel to retain the original settings. 

10.7.3 Component properties 
1. In the GC tab, double-click on the desired component. The Component Configuration dialog box 

will be highlighted. 

2. Enter the appropriate information in the fields in the Current Component Properties area. 
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3. Click OK to save the changes or click Cancel to retain the original settings. 

10.7.4 Complete PGC2000 configuration 
1. When you have completed all entries, click the Address Configuration icon on the Client 

Configurator toolbar to assign registers. 

2. Click the Save Configuration icon on the Toolbar. 

3. When the Save Configuration File window appears, enter the desired file name and click Save. 

10.8 Multiwave configuration 
To verify or set a Multiwave’s (MW) configuration, use the Client Configurator (see Figure 10-1).  

To add or edit a Multiwave: 

1. Click the MW2000 tab. 

2. Review the list of devices shown in the MW tab. 

3. In the MW2000s field to the right of the window, use the up/down control to add or delete MWs 
(see Figure 10-12). The MW Properties dialog box will be highlighted. 

Figure 10-12: Typical MW Configuration Dialog Box 

 

10.8.1 MW properties 
1. Click on the desired MW listed in the MW tab. 

2. If a Modbus address is required, enter the Modbus Address for this MW using the up/down 
control. 

3. Enter the network identification number for this MW in the Network ID box. This is how the MW 
is named. 

4. If desired, enter the plant's identification for this MW in the MW Alias field. 

5. To configure alarms, click Configure Alarms. 
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6. When the Alarm Configuration window appears (see Figure 10-10), check each alarm to be 
configured, select Register Type (Input Status or Coil Status) and, if necessary, enter a 
Register Number. 

7. In the Components field, use the up/down control to enter the desired number of components 
(each stream must have at least one component). 

10.8.2 Component properties 
1. On the MW tab, click on the desired component. The Component Properties dialog box will be 

highlighted. 

2. Enter the appropriate information in the fields in the Component Properties dialog box 

10.8.3 Complete MW configuration 
1. When you have completed all entries, click on the Address Configuration icon on the Client 

Configurator toolbar to assign registers. 

2. Click the Save Configuration icon on the toolbar. 

3. When the Save Configuration File window appears, enter the desired file name and click Save. 

10.9 RVP configuration 
To verify or set an RVP's configuration, use the Client Configurator (see Figure 10-1).  

To add or edit an RVP: 

1. Click on the RVP tab. 

2. Review the list of devices shown in the RVP tab. 

3. In the RVP field to the right of the window, use the up/down control to add or delete RVPs (see 
Figure 10-13). The Current RVP Properties dialog box will be highlighted. 

Figure 10-13: Typical RVP Configuration Dialog Box 

 
4. Click on the desired RVP listed in the RVP tab. 

5. If a Modbus address is required, enter the Modbus Address for this RVP using the up/down 
control. 
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6. If needed, enter the OPC Location for this RVP using the up/down control. 

7. If needed, enter the Remote Number for this RVP in the Remote Number field. 

8. When you have completed all entries, click the Address Configuration icon on the Client 
Configurator toolbar to assign registers. 

9. Click the Save Configuration icon on the Toolbar. 

10. When the Save Configuration File window appears, enter the desired file name and click Save. 

 

11 Legacy products 
Although the products covered in this section have been discontinued, many of them are installed in 
existing equipment.  

11.1 GCC RUI (PGC2000/3100) 
To access an RUI, choose the desired RUI icon on the desktop or launch from the STAR Client. The 
title bar identifies the specific RUI you have accessed. To bring up the GCC-RUI window, choose 
Connect in the File menu to access the Remote GCC Address window (see Figure 11-1). 

Figure 11-1: Remote GCC Address Window 

 
Choose the desired GCC and select an address from the Address List. Then click OK. The RUI presents 
the Status Display screen (see Figure 11-2). 

Figure 11-2: GCC Status Display Screen 
Status Pane

Report
Pane

Alarm
Pane

SQC
Pane

 
The Status pane, Alarm pane, and Report pane display. 

The SQC pane can display up to eight sets of statistical data. To view a particular data set, click 
Select, then choose the desired data set from the menu. 

The items in the Menu Bar have submenus to help divide the various tasks to be done. Functions 
labeled as analyzer functions perform in the same manner as they do at the analyzer. Use the 
analyzer manual to assist you in performing these functions. The menu items and subitems are as 
follows: 
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The functions not identified as analyzer functions perform the following tasks: 

 File menu items 
• Save Tbls: Saves the GCC-RUI's current tables to the selected location 
• Load Tbls: Loads the tables into the GCC-RUI 
• Print Tbls: Prints the GCC-RUI's current tables 
• Print Report: Prints the selected report 
• Disconnect: Disconnects the RUI from the selected analyzer 

 View menu items 
• Application Data: For future expansion 
• Chromatogram: Allows you to view and save chromatograms from the analyzer 
• Status Bar: Displays a windows status bar 
• Toolbar: Displays a windows toolbar 
• RUI Colors: Lets you select the desired colors for the RUI window separately for each pane 
• RUI Fonts:  Lets you select the desired fonts for the RUI window separately for each pane 

11.2 Router assembly 
The VistaNET Router Assembly is used when some or all analytical devices connected to VistaNET 
utilize the VistaNET Communication PCBs (and in low-speed systems, the VistaNET Interconnect PCB).  
If all analytical devices use an Ethernet PCB, the Router Assembly is not necessary. 

The VistaNET Router Assembly connects VistaNET applications to an analytical network. The only user 
function for the VN2300D Router Assembly is a web interface. The VN2300DM Modbus-enabled Router 
also has the HIU-RUI. 

11.3 Report viewer 
The Report Viewer allows you to view or print various PGC5000 reports and chromatograms (for 
PGC5000 prior to version 4). To access the Report Viewer, click Run Viewer at the top left of any 
Remote Client (RUI) screen. 

11.4 VistaSTORAGE 

 

IMPORTANT NOTE: VistaSTORAGE can only store results from single detector, simulated 
distillation, and simultaneous dual detector GCCs. 

VistaSTORAGE archives analytical results. It stores the analytical results from each analyzer in a 
circular database that can support seven days of data. When the file has accumulated seven days of 
data, VistaSTORAGE discards the oldest day’s results, replacing them with the current day’s results.  
In this manner, you can always access the most recent week’s results. 
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VistaSTORAGE automatically creates a subdirectory in the ABB directory named Databases and stores 
all the databases used by VistaSTORAGE (files with “.mdb” extension) in this subdirectory. 

VistaSTORAGE has two types of databases: master (one database for the system) and instrument 
(one database for each analytical device). VistaSTORAGE creates the instrument databases as it 
receives data from each analytical device. When VistaSTORAGE creates an instrument database, the 
name of the instrument database file will appear on the VistaSTORAGE window. 

When you click on the VistaSTORAGE icon or Taskbar button, the VistaSTORAGE window appears (see 
Figure 11-3). This window is read-only. 

Figure 11-3: VistaSTORAGE Window 

 
The first two letters of each Database Name refer to the device type: 

 GC - single detector GCC 
 DD - simultaneous dual detector GCC 
 SD - simulated distillation GCC. 

 

NOTICE – Loss of data risk. The remainder of the name consists of the device’s VistaNET 
address. 

Do not exit the VistaSTORAGE window, as this action will cause VistaSTORAGE to stop 
collecting data. 

When you have finished looking at the VistaSTORAGE information, minimize the window.  

In addition to storing the analysis results, VistaSTORAGE performs analyzer availability calculations. 
You can view the results of these calculations, along with the archived analytical results, with 
VistaSAM. 

11.5 VistaSAM 

 

IMPORTANT NOTE: Proper operation of VistaSAM requires you to set the Window date function to 
"English (United States)." You can set or verify the date format by clicking on 
Start/Settings/Control Panel/Regional Settings. 

VistaSAM generates text and graphical reports from data collected by VistaSTORAGE.   

VistaSAM requires you to select a master base and database path, followed by opening the instrument 
database. When you open the instrument database, a list of analytical device tags will appear on the 
screen. From this list you can select the analytical device to generate reports for. 

To start VistaSAM: 

1. Click File. 

2. Click Open Master Database (see Figure 11-4). 
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Figure 11-4: Open Master Database Screen 

 
3. Locate the folder for the desired instrument, choose databases, and then click OK (see Figure 

11-5). 

Figure 11-5: Set Database Path Window 

 
4. Verify that the Selected Path shows the desired database. 

5. When the device list appears, click on the device for which you want to generate reports (see 
Figure 11-6). 
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Figure 11-6: VistaSAM Device Screen 

 
6. Click on the View menu. 

7. From the report type selection list, click the desired type of report (see Figure 11-7): 

• Display reports 
• Trend charts 
• SQC charts  
• Analyzer availability charts and reports 

Figure 11-7: Report Selection Screen 

 
The next few paragraphs discuss these report types in detail. 

11.5.1 Display reports 
You can view analysis, benchmark, and calibration reports for any given instrument. 

After you select the instrument from the list: 

1. Click View. 

2. Click Display Reports and the Report Type selection dialog box will appear (see Figure 11-8). 
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Figure 11-8: Report Type Screen 

Report Type X

Regular Analysis

Standards

 
Click the Standards button to view calibration and benchmark reports. Click the Regular Analysis 
button to view all stream reports. 

3. Click on the Standards or Regular Analysis button and the appropriate Report table will appear 
(Figure 11-9 shows the Regular Analysis table). 

Figure 11-9: Regular Analysis Table Screen 

 
This table allows you to select any analysis report from the previously selected analytical device for 
viewing or printing. From the drop-down lists in this table, select the desired report by stream (for 
regular analysis), method (for standards), and sample inject time and date. The data presented in the 
report consists of: 

 Component name 
 Retention time 
 Concentration/response factor 
 Uncorrected peak height 
 Uncorrected peak area 
 Corrected peak height 
 Corrected peak area 
 Slope sensitivity 
 Peak width 
 Start time 
 Start amplitude 
 End time 
 End amplitude 

4. To eliminate some of this data from the current report, click File. 

5. Click Options Reports and the Report Options dialog box will appear (see Figure 11-10). 
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Figure 11-10: Options Report Window 

 
6. Clear any type of data not desired in the current report. 

11.5.2 Trend charts: introduction 
To view the analytical data in graphical format, click Trend Charts in the View menu. There are four 
types of trend charts: normal (Trend chart), statistical (SQC), split Y axes, and X vs. Y charts. You can 
select the desired chart from the Edit menu. 

11.5.3 Trend charts: normal trend chart 
The normal trend chart shows by default (see Figure 11-11). 

Figure 11-11: Normal Trend Chart 

 
To change the chart attributes, right-click. From the top-level menu, select submenu items by placing 
the mouse cursor on a menu item that has a right arrow. Figure 11-12 shows the available menu 
items. 
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Figure 11-12: Menu Structure (All Charts) 

Viewing Style
Font Size
Numeric Precision No Decimals

1 Decimal
2 Decimals
3 Decimals

Large
Medium
Small

Color
Monochrome
Monochrome+Symbols

Plotting Method Line
Bar
Point
Area
Points+BestFitLine
Points+BestFitLineII
Points+BestFitCurve
Points+BestFitCurveII
Points+Line
Points+Spline
Spline
Histogram

Data Shadows

Grid Lines Both Y and X Axis
Y Axis
X Axis
No Grid

Grid in Front
Graph or Table

What to Table

Pont Label Orientation
Comparisons as Normal
Mark Data Points
Show Annotations
Undo Zoom
Maximize
Customization Dialog
Export Dialog
Help

Graph
Table
Graph with TableGraphed Subsets

All Subsets
Auto
Vertical
Horizontal
Slanted

Off
Shadow
3D

 
The Chart Element Selection dialog box will appear, allowing you to select the desired chart options 
(see Figure 11-13). 

Figure 11-13: Chart Element Selection Dialog Box 

 
You can trend multiple attributes for the same component by checking them in the Select items to 
chart group or you can chart the same property for multiple components by clicking the component 
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name in the Components Available list. To remove a component from the Current Components 
Selection list, click on the component name and then click Remove Component. 

 

IMPORTANT NOTE: You cannot trend multiple attributes from multiple components in a normal 
trend chart. 

The stream selected in the Select Stream list, and time period selected from Start Time to End Time 
(on the Normal Trend Chart) set the limits of the data shown on the trend chart. To display changes 
to any of these selections, click Redraw. 

VistaSAM automatically determines a range for the Y-axis. However, you can change the maximum 
and minimum Y-axis values by selecting the Y-Axis Control option at the Edit menu.  The Y AXIS 
Settings dialog box will then appear (see Figure 11-14), from which you can change the Y-axis 
settings. 

Figure 11-14:  Y Axis Settings Dialog Box 

 

11.5.4 Trend charts: statistical chart 
The statistical chart represents another variation of the trend chart (see Figure 11-15). You can 
access this by clicking SQC from the Edit menu. The statistical chart is simply a normal trend chart to 
which lines representing the mean, ±2 standard deviations, and ±3 standard deviations have been 
added. VistaSAM automatically calculates the statistical values on the currently displayed data. 
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Figure 11-15: Statistical Chart 

 

11.5.5 Trend charts: split y axes chart 
When trending multiple attributes or components, they may not fit in a single range with adequate 
graphic visibility. For example, if one attribute ranged in value from 0 to 1 and another ranged from 
10000 to 10010, the range for both values would range between 0 and 10010.  However, since the 
range for each attribute is so small, you would not have enough resolution to discern changes in each 
attribute. For this situation VistaSAM provides the split Y Axes chart (see Figure 11-16). 

Figure 11-16: Split Y Axes Chart 

 
To access this chart, select the Split Y Axes option from the Edit menu. This chart will display each 
attribute (up to six attributes) with a separate auto-ranged y axis. 

11.5.6 Trend charts: x vs y chart 
To create the XVSY (X vs. Y) chart, click XVSY from the Edit menu. The X vs. Y Chart Element dialog 
box will prompt you for the needed information (see Figure 11-17). 
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Figure 11-17: X vs Y Settings Dialog Box 

 
In this dialog box, you can select the Set X Axis and Set Y Axis buttons. When you make a selection, 
VistaSAM will use the combination of attribute and component active at the time for that particular 
axis in the chart (see Figure 11-18). 

Figure 11-18: X vs Y Chart 

 

11.5.7 SQC charts 
SQC charts look like statistical trend charts except SQC charts use only calibration and benchmark 
data (see Figure 11-19). To view these charts, select SQC Charts from the View menu. As in the 
trend charts, you may select the stream (only benchmark and calibration streams are now available) 
and start/end times. However, you may also select the component from the Component to View list.  
Right-click to bring up the trend chart Menu structure. 
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Figure 11-19: SQC Chart 

 
To graph a different component attribute, select Property to Chart from the Edit menu and click the 
attribute to be graphed at the SQC Item Selection dialog box (see Figure 11-20). 

Figure 11-20: SQC Item Selection Dialog Box 

 

11.6 Analyzer availability 
Analyzer Availability is a maintenance function that is explained in the STAR Administrator's Guide 
2300-AG. 

 

12 Glossary 
Term  Definition 
ACL Access Control List 
STAR Gateway Unit in the STAR system that connects STAR to the DCS through the 

Analytical Network 
DCS Distributed Control System 
Device Definition Table  List of STAR devices available to perform a service when requested 
Domain Group of networked computers  that share a common communications 

address 
GCC Gas Chromatograph Controller (part of PGC2000 series analyzer) 
HIU Host Interface Unit 
HIU-RUI see Remote User Interface 
IP Internet Protocol 
LAN Local Area Network 
LUI Local User Interface 
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Term  Definition 
MW Multiwave 
MW-RUI see Remote User Interface 
NIS Network Information Service 
OPC Open Platform Communications 
OPCRUI OPC Remote User Interface 
Packet unit of a message 
PC Personal Computer 
PCB Printed Circuit Board 
PGC2000/3100 PGC2000/3100 Series Process Gas Chromatograph 
PGC5000 PGC5000 Series Process Gas Chromatograph 
Remote User Interface (RUI) Series of software products that enables the operator to have remote access 

to a PGC5000, HIU, MW, or OPC, and provides network configuration. RUI 
software is titled by its function: OPCRUI, MW-RUI, etc. 

Reporter Software application that accepts analysis results, alarms, and other events 
from analyzers on the STAR system and displays them on an attached 
monitor or printer, or sends them to a hard disk for storage 

Report Viewer A software application that allows you to view analysis data and 
configuration information used to create an analysis; used only with the 
PGC5000 Version 3 

Router VistaNET Router Assembly, a unit in the VistaNET system that acts as a 
protocol converter between VistaNET and Ethernet 

RUI see Remote User Interface 
RVP Reid Vapor Pressure Analyzer 
Server List see Subscriber List 
Subscriber Device which receives data from another device 
Subscriber List List of applications to which data is sent 
TCF Time Coded Function 
VistaSAM VistaNET Statistical Analyzer Management, PC software that generates text 

and graphical reports from data collected by VistaSTORAGE 
VistaSTORAGE A software application that creates a database for use in trending SQC, etc. 
VNSA  VistaNET Name Service Application. PC software that serves as the address 

book for the VistaNET. VNSA maintains and distributes current system 
configuration information such as device names, routing, and User Password 
tables for VistaNET 2.0 devices/applications 

VNSA-RUI A VistaRUI software product that enables you to have remote access to a 
VNSA, and it provides network configuration 
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